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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in 
the box.

Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       
To find the next occurrence of the word, Do one of the following:
           
            Choose Edit > Find Again 
            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.
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To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 
(Mac OS) as you drag across the width of the document. 
       
To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 
(Mac OS) as you drag the length of the document.
        
To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 
on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 
in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [REPORT OF ACTION TAKEN IN CLOSED SESSION

2 ON FEBRUARY 23, 2010, BEGINS ON PAGE 67.]

3

4

5

6 SUP. MOLINA, CHAIR: WE'RE GOING TO BEGIN THIS MORNING'S 

7 MEETING. THIS MORNING OUR INVOCATION WILL BE LED BY PASTOR REX 

8 FURMAN OF LANCASTER. OUR PLEDGE THIS MORNING WILL BE LED BY 

9 DEPARTMENT OF MILITARY AND VETERANS AFFAIRS, BOB SAXON. SO 

10 PASTOR? WELCOME AND THANK YOU. WOULD YOU ALL PLEASE STAND? 

11

12 PASTOR REX FURMAN: JUST FOR A MOMENT BEFORE I PRAY, I WOULD 

13 LIKE TO TAKE A MOMENT TO THANK THE COUNCIL FOR THEIR LOVE AND 

14 THEIR CARE FOR OUR FAMILY DURING THE STATION FIRE. YOUR 

15 SUPPORT, THE WAY YOU REACHED OUT TO US, THE COMMENTS THAT WERE 

16 MADE AT DODGER STADIUM, ALL OF THOSE THINGS REALLY TOUCHED OUR 

17 HEARTS AND THEY MADE US FEEL LIKE WE WEREN'T ALONE. YOU JUST 

18 REACHED BEYOND THAT. AND WE HAVE SO MUCH TO BE APPRECIATIVE 

19 OF. THANK YOU VERY MUCH FOR THOSE THINGS AND FOR COUNCILMAN 

20 ANTONOVICH, HE CALLED ME PERSONALLY, SAID "HERE'S MY PERSONAL 

21 NUMBER. IF YOU HAVE ANYTHING YOU NEED, LET ME KNOW." WE DIDN'T 

22 CALL THE NUMBER, BUT THE KNOW THE NUMBER WAS AVAILABLE MEANT 

23 SO MUCH TO US. SO THANK YOU FROM OUR FAMILY, FROM ARNIE'S 

24 FAMILY, LET'S PRAY. FATHER, WE COME TO YOU TODAY AND THANK YOU 

25 FOR THIS COUNCIL FOR IN YOUR WORD, YOU SAID IN THE MULTITUDE 
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1 OF COUNCILORS, THERE WANTETH NOT WISDOM. WE THANK YOU THAT IT 

2 IS NOT JUST ONE PERSON, WHOEVER THEY ARE, MAKING ALL OF THOSE 

3 DECISIONS. BUT AS COUNCILORS, STUDY TO SHOW THEMSELVES 

4 APPROVED, AS THEY GIVE THEMSELVES TO THINKING CAREFULLY ABOUT 

5 WHAT HAPPENS, WE SEE STABILITY IN OUR COUNTY THAT GOES BACK 

6 MANY, MANY YEARS AND HAS GIVEN US A CONFIDENCE THAT WHILE ALL 

7 THE REST OF THE WORLD CAN SEEM TO BE IN SUCH STRESS AND WE 

8 KNOW THE WRESTLING WITH BUDGETS HERE AND TIME AND THINGS THAT 

9 MUST HAPPEN IS AN EVENT THAT JUST CONTINUES TO GO ON. WE THANK 

10 YOU FOR THE STABILITY. WE THANK YOU THAT COUNCILORS CAN TALK 

11 WITH ONE ANOTHER AND STUDY AND THINK ABOUT WHAT SHOULD HAPPEN. 

12 WE THANK YOU THAT IRON SHARPENS IRON AND THAT THE GROWTH IS 

13 THERE. SO, FATHER, WATCH OVER AND GUIDE THIS MEETING, BUT WE 

14 WOULD ALSO, AS IN OUR FAMILY, WE WOULD ASK AND PRAY FOR THEIR 

15 PERSONAL FAMILIES, THEIR PERSONAL LIVES, THAT YOU WOULD GUIDE 

16 AND GIVE DIRECTION AND WISDOM THERE. THEN THANK YOU, TOO, FOR 

17 THIS COUNTRY WE LIVE IN, FOR THIS PLACE WE LIVE AND FOR THE 

18 CONFIDENCE WE HAVE THAT YOU ARE OUR GOD AND YOU REIGN AND AS 

19 YOUR CHILDREN, WE CAN FIND STRENGTH IN YOU. WE THANK YOU FOR 

20 THAT. THANK YOU FOR BEING OUR GOD. WE THANK YOU, SAYING AMEN. 

21

22 BOB SAXON: PLEASE FACE THE FLAG AND FOLLOW ME IN SAYING THE 

23 PLEDGE OF ALLEGIANCE. I PLEDGE ALLEGIANCE TO THE UNITED STATES 

24 OF AMERICA AND TO THE REPUBLIC FOR WHICH IT STANDS, ONE 
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1 NATION, UNDER GOD, INDIVISIBLE, WITH LIBERTY AND JUSTICE FOR 

2 ALL. THANK YOU. PLEASE BE SEATED. 

3

4 SUP. MOLINA, CHAIR: SUPERVISOR ANTONOVICH. 

5

6 SUP. ANTONOVICH: WELL IT'S A PLEASURE TO RECOGNIZE PASTOR REX 

7 FURMAN HERE. HE GAVE OUR PRAYER 20 YEARS AGO. BORN IN NEW 

8 YORK, GRADUATED A BUSINESS MAJOR UNIVERSITY AND THEN JOINED 

9 HIS FAMILY'S PLUMBING COMPANY AND THEN LATER BECAME A FIREMAN. 

10 THEN HE HAD ANOTHER CALLING AND HE MOVED TO THE SANTA CLARITA 

11 VALLEY WHERE HE ATTENDED THE MASTER SEMINARY AND BECAME A 

12 MEMBER OF THE CLERGY. AND THEN BECAME A PASTOR OF BETHEL 

13 BAPTIST CHURCH IN LANCASTER IN ANTELOPE VALLEY WHERE HE'S BEEN 

14 THE PASTOR FOR 28 YEARS. CURRENTLY LIVES IN LANCASTER. HE 

15 SERVES AS THE INTERNATIONAL FIELDS DIRECTOR OF THE INDEPENDENT 

16 GOSPEL MISSIONS WHICH OVERSEES 23 COUNTRIES AROUND THE WORLD, 

17 RECENTLY IN HAITI GIVING ASSISTANCE THERE. THEY HAVE THREE 

18 CHILDREN AND FOUR GRANDCHILDREN. THEIR DAUGHTER, LARISSA WAS 

19 MARRIED TO OUR L.A. COUNTY FIREFIGHTER ARTIE QUIONES, WHO WAS 

20 TRAGICALLY KILLED IN THAT DEVASTATING STATION FIRE AND THEIR 

21 LITTLE BABY DAUGHTER HAS JUST TURNED FIVE MONTHS OLD. SHE WAS 

22 BORN AFTER HER FATHER PASSED AWAY. SO, PASTOR, THANK YOU FOR 

23 COMING DOWN AND LEADING US IN PRAYER AND FOR YOUR LEADERSHIP 

24 IN OUR COMMUNITY, COUNTY AND NATION. [APPLAUSE.] 

25
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1 SUP. MOLINA, CHAIR: THANK YOU, PASTOR. ALL RIGHT. I'M GOING TO 

2 HAVE THE EXECUTIVE OFFICER TO PLEASE CALL THE AGENDA. 

3

4 CLERK SACHI HAMAI: GOOD MORNING, MADAME CHAIR, MEMBERS OF THE 

5 BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 2, PRESENTATIONS 

6 AND SET MATTERS. ON ITEM S-1, AS INDICATED ON THE POSTED 

7 AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE 

8 CONTINUED TO MARCH 2ND, 2010 AT 11 A.M. 

9

10 SUP. MOLINA, CHAIR: SO ORDERED. ITEM S-1. 

11

12 CLERK SACHI HAMAI: ON PAGE 3, PUBLIC HEARINGS, ITEMS 1 AND 2, 

13 WE WILL HOLD FOR A PUBLIC HEARING. ON PAGE 4, ADMINISTRATIVE 

14 MATTERS, BOARD OF SUPERVISORS ITEMS 3 THROUGH 9? 

15

16 SUP. MOLINA, CHAIR: ON THOSE ITEMS, MOVED BY SUPERVISOR 

17 ANTONOVICH. SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO 

18 OBJECTION, SO ORDERED. 

19

20 CLERK SACHI HAMAI: ON PAGE 6, CONSENT CALENDAR, ITEMS 10 

21 THROUGH 24. ON ITEM NO. 10, AS INDICATED ON THE POSTED AGENDA, 

22 THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE 

23 CONTINUED ONE WEEK TO MARCH 2ND, 2010. 

24

25 SUP. MOLINA, CHAIR: SO ORDERED. 



February 23, 2010

7

1

2 CLERK SACHI HAMAI: ON ITEM NO. 11, AS INDICATED ON THE 

3 SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT 

4 THIS ITEM BE CONTINUED ONE WEEK TO MARCH 2ND, 2010. 

5

6 SUP. MOLINA, CHAIR: SO ORDERED AS WELL. 

7

8 CLERK SACHI HAMAI: ON ITEM NO. 13, AS INDICATED ON THE 

9 SUPPLEMENTAL AGENDA, THE DIRECTOR OF MENTAL HEALTH REQUESTS 

10 THAT THIS ITEM BE REFERRED BACK TO HIS OFFICE. 

11

12 SUP. MOLINA, CHAIR: THAT WILL BE REFERRED BACK. THIS IS ITEM 

13 13. 

14

15 CLERK SACHI HAMAI: ON ITEM NO. 15 AS INDICATED ON IF 

16 SUPPLEMENTAL AN AGENDA. THE DIRECTOR OF PUBLIC HEALTH REQUESTS 

17 THAT THIS ITEM BE CONTINUED ONE WEEK TO MARCH 2ND, 2010. 

18

19 SUP. MOLINA, CHAIR: SO ORDERED ON THAT CONTINUANCE. 

20

21 CLERK SACHI HAMAI: ON ITEM NO. 16 THERE IS A REQUEST FROM A 

22 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 17, THIS 

23 ALSO INCLUDES THE REVISION AS INDICATED ON THE SUPPLEMENTAL 

24 AGENDA. ON ITEM NO. 18, WE WILL CONTINUE THIS ITEM ONE WEEK TO 

25 MARCH 2ND, 2010, DUE TO A LACK OF FOUR VOTES. ON ITEM NO. 19, 
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1 THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THE CORRECTIVE 

2 ACTION PLAN BE CONTINUED SIX WEEKS TO APRIL 6TH, 2010, THAT 

3 THE SETTLEMENT BE APPROVED TODAY. ON ITEM NO. 20, AS INDICATED 

4 ON THE SUPPLEMENTAL AGENDA, SUPERVISOR KNABE REQUESTS THAT 

5 THIS ITEM BE CONTINUED WITHOUT DISCUSSION FOR TWO WEEKS TO 

6 MARCH 9TH, 2010. AND THE REMAINING ITEMS UNDER THE CONSENT 

7 CALENDAR ARE BEFORE YOU. 

8

9 SUP. MOLINA, CHAIR: ON THOSE ITEMS THAT ARE BEFORE US, MOVED 

10 BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR MIKE 

11 ANTONOVICH. IF THERE IS NO OBJECTION, SO ORDERED. 

12

13 CLERK SACHI HAMAI: WE'RE NOW ON PAGE 15, NOTICES OF CLOSED 

14 SESSION. ON ITEM NO. C.S.-2, AS INDICATED ON THE SUPPLEMENTAL 

15 AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE 

16 CONTINUED ONE WEEK TO MARCH 2ND, 2010. ON ITEM C.S.-3, AS 

17 INDICATED ON THE SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-THOMAS 

18 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO MARCH 2ND, 

19 2010. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF 

20 SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT 

21 NO. 2. 

22

23 SUP. MOLINA, CHAIR: ALL RIGHT. IF WE COULD BEGIN WITH SOME 

24 PRESENTATIONS. I'D LIKE TO MAKE A PRESENTATION. WE HAVE TODAY 

25 WITH US A WELCOME TO A CONSUL GENERAL. I ASK HIM TO COME UP 
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1 AND JOIN ME IF YOU WOULD. IT'S MY HONOR THIS MORNING TO 

2 WELCOME AND TO PRESENT TO THE BOARD THE HONORABLE ENRIQUE 

3 LOEDEL. HE IS THE NEW CONSUL GENERAL FOR URUGUAY HERE IN LOS 

4 ANGELES. HE HAS SERVED IN THE EMBASSIES OF URUGUAY IN AUSTRIA 

5 AND GERMANY, AS THE CONSULATE OF URUGUAY IN ISTANBUL AND THE 

6 PERMANENT MISSIONS OF URUGUAY IN THE UNITED NATIONS IN NEW 

7 YORK AS WELL AS IN VIENNA. AT THE HEADQUARTERS OF URUGUAY'S 

8 FOREIGN MINISTRY HE HAS SERVED AS A CABINET AND FOREIGN 

9 MINISTER AND IN THE DIVISIONS OF THE FOREIGN POLICY OF LATIN 

10 AMERICAN AFFAIRS. HE ATTENDED THE UNIVERSITIES OF FRANCE AND 

11 THE UNITED KINGDOM AS WELL AS URUGUAY AND HE HAS EARNED A LAW, 

12 POLITICAL SCIENCE AND INTERNATIONAL DEGREES WITH A 

13 SPECIALIZATION IN PUBLIC INTERNATIONAL LAW. HE HAS ALSO SERVED 

14 AS A GUEST LECTURER IN SEVERAL UNIVERSITIES INCLUDING YALE IN 

15 OUR COUNTRY. AS THE CONSUL GENERAL HERE IN LOS ANGELES, IT IS 

16 MY UNDERSTANDING YOU HAVE JURISDICTION OVER, WHAT? 13 STATES. 

17 SO HE HAS A VERY, VERY LARGE RESPONSIBILITY AND MISSION. IT IS 

18 INDEED MY HONOR TO WELCOME YOU AND TO LET YOU KNOW THAT WE ARE 

19 HERE AND AVAILABLE TO YOU FOR WHATEVER YOU MAY NEED AND WE'RE 

20 VERY PROUD THAT YOU'RE SERVING HERE IN LOS ANGELES COUNTY. 

21 BIENVENIDO. 

22

23 HON. ENRIQUE LOEDEL: THANK YOU VERY MUCH. [APPLAUSE.] CONSUL. 

24
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1 SUP. MOLINA, CHAIR: CONSUL GENERAL, WOULD YOU SHARE A FEW 

2 WORDS WITH US IF YOU WOULD? 

3

4 HON. ENRIQUE LOEDEL: THANK YOU VERY MUCH. IT IS BOTH AN HONOR 

5 AND A PLEASURE TO BE HERE TODAY. THE RELATIONSHIP BETWEEN 

6 URUGUAY AND CALIFORNIA IS QUITE LONG AND HAS BEEN VERY 

7 FRUITFUL THROUGHOUT TIME. SHORT AFTER THE INDEPENDENCE OF 

8 URUGUAY, ONE OF THE FIRST REPRESENTATIVES OF THE U.S. IN 

9 URUGUAY WAS FROM THIS PART OF THE COUNTRY. AND SINCE HIS 

10 PRESENCE THERE AND UNTIL, WELL, QUITE RECENTLY, THE U.S. 

11 AMBASSADOR WHO RETURNED A FEW MONTHS AGO FROM URUGUAY, MR. 

12 FRANK BAXTER, HE'S AN ANGELINO, TOO. SO IT HAS BEEN A VERY 

13 CLOSE RELATIONSHIP, NOT ONLY BETWEEN THE U.S. AND URUGUAY BUT 

14 BETWEEN CALIFORNIA AND THE CITY OF LOS ANGELES AND URUGUAY. 

15 UNLIKE OTHER COMMUNITIES, OUR COMMUNITY HERE IS QUITE SMALL, 

16 BUT I DO HOPE THAT IT WILL ADD TO THE DIVERSITY AND TO ALL THE 

17 THINGS THAT THIS CITY EMBRACES IN TERMS OF EXCELLENCE OF 

18 INCORPORATING NEW PEOPLE, NEW IDEAS AND WHATEVER HAPPENS IN 

19 THE WORLD, MY SHORT TIME HERE HAS TAUGHT ME THAT IT'S ALWAYS 

20 WELCOME HERE. SO I'M VERY HAPPY TO BE HERE TODAY AND VERY 

21 HONORED. THANK YOU. 

22

23 SUP. MOLINA, CHAIR: BIENVENIDO. THANK YOU SO MUCH. [APPLAUSE.] 

24 MIKE, YOUR PRESENTATIONS? 

25
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1 SUP. ANTONOVICH: TODAY WE'RE GOING TO RECOGNIZE ROBIN TOMA, 

2 WHO IS THE ASSISTANT DIRECTOR, COMMUNITY SENIOR SERVICES, 

3 EXECUTIVE DIRECTOR OF HUMAN RELATIONS COMMISSION. RON TOMA HIS 

4 FATHER AND MARY HIS MOTHER AND ANNETTE WESS AND SANDRA THOMAS, 

5 OUR PRESIDENT OF THE HUMAN RELATIONS COMMISSION AND MY 

6 APPOINTEE TO THE HUMAN RELATIONS COMMISSION, IN RECOGNITION 

7 FOR ROBIN'S RECEIVING THE CALIFORNIA FAIR EMPLOYMENT HOUSING 

8 ACT'S 50TH ANNIVERSARY CIVIL RIGHTS AWARD. THIS IS PRESENTED 

9 TO HIM BY THE DIRECTOR OF THE STATE DEPARTMENT OF FAIR 

10 EMPLOYMENT AND HOUSING FOR DEDICATION IN ADVANCING CIVIL AND 

11 HUMAN RIGHTS FOR ALL PEOPLE. CURRENTLY AS PRESIDENT OF THE 

12 BOARD OF DIRECTORS OF THE CALIFORNIA ASSOCIATION OF HUMAN 

13 RELATIONS ORGANIZATIONS, WHICH IS THE ONLY STATEWIDE 

14 ORGANIZATION THAT BRINGS TOGETHER CALIFORNIA CITIES AND 

15 COUNTIES BASED UPON HUMAN RELATIONS AGENCIES. ALSO A MEMBER OF 

16 THE BOARD OF DIRECTORS OF THE INTERNATIONAL ASSOCIATION OF 

17 OFFICIAL HUMAN RIGHTS AGENCIES SINCE 2007. AS PART OF THE 

18 HARVARD UNIVERSITY KENNEDY SCHOOL OF GOVERNMENT EXECUTIVE 

19 SESSION ON HUMAN RIGHTS AND THE CRIMINAL JUSTICE SYSTEM, ROBIN 

20 WAS INVOLVED THERE FROM 2006 TO 2008. AND DURING WHICH HE WAS 

21 AMONG A SMALL NUMBER OF EXECUTIVES FROM VARIOUS HUMAN RIGHTS 

22 RELATIONS AGENCIES AND POLICE DEPARTMENTS, WHICH WAS BROUGHT 

23 TO HARVARD TO DEVELOP AND INNOVATIVE PROGRAM THAT WOULD 

24 IMPROVE POLICE COMMUNITY RELATIONS AND EFFECTIVE POLICING. HE 

25 IS ALSO FLUENT IN SPANISH AND PLAYED A LEADERSHIP ROLE IN 
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1 ADOPTION OF POLICY PROTOCOLS FOR THE LOS ANGELES POLICE 

2 DEPARTMENT. CONGRATULATIONS, ROBIN. AND HERE IS A LITTLE 

3 PROCLAMATION ON YOUR AWARD. [APPLAUSE.] 

4

5 ROBIN TOMA: THANK YOU SO MUCH, SUPERVISOR ANTONOVICH AND 

6 MEMBERS OF THE BOARD. OFTENTIMES RECOGNITION LIKE THIS COMES 

7 ONLY AFTER YOU RETIRED OR PASSED ON, SO I'M VERY GLAD I'M NOT 

8 IN EITHER OF THOSE SITUATIONS. BUT I'M VERY PLEASED THAT I 

9 ACTUALLY HAVE ME TODAY MY PARENTS, RON AND MARY TOMA WHO HAVE 

10 BEEN FACED WITH HEALTH CHALLENGES OVER THE PAST YEARS, BOTH 

11 HAVING STROKES IN THE PAST YEARS AND JUST MOST RECENTLY MY 

12 MOTHER JUST GOT OUT OF THE HOSPITAL A FEW DAYS AGO, SO I'M 

13 ESPECIALLY PLEASED THAT THEY COULD BE HERE. AFTER ALL, YOU 

14 KNOW, OUR PARENTS ARE FORMATIVE FOR US IN OUR LIVES. I'M NOT 

15 GOING TO CHARGE THEM WITH ALL THE BAD THINGS THAT I'VE DONE OR 

16 I'VE BECOME, BUT CERTAINLY I GIVE THEM CREDIT FOR ALL THE GOOD 

17 THAT'S IN ME. AND I ALSO WANT TO THANK NANETTE WEST WHO IS 

18 THEIR HOME CARE CAREGIVER WHO WITHOUT HER, THEY WOULDN'T BE 

19 ABLE TO BE HERE TODAY. I JUST ALSO WOULD LIKE TO THANK SANDRA 

20 THOMAS, WHO IS OUR FEARLESS LEADER AS PRESIDENT OF THE 

21 COMMISSION WHO HAS BEEN WONDERFUL TO WORK WITH, CYNTHIA BANKS, 

22 DIRECTOR OF THE DEPARTMENT, WHOSE LEADERSHIP HAS BEEN 

23 EXEMPLARY AND HAS MADE OUR MERGER WITH THE DEPARTMENT REALLY 

24 WONDERFUL. AND THE TRUTH IS THAT NONE OF THE WORK THAT I'VE 

25 DONE COULD NOT HAPPEN ON MY OWN. AS ALL OF YOU KNOW, WE ALL 
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1 DEPEND ON SO MANY PEOPLE, INCLUDING MEMBERS OF THIS BOARD, 

2 THEIR STAFF, C.E.O., HIS STAFF, AND SO MANY COUNTLESS OTHERS 

3 WHO SUPPORT US, COLLABORATE, COOPERATE AND REALLY MAKE IT 

4 HAPPEN. SO I REALLY WANT TO CREDIT ALL OF THOSE PEOPLE WHO, 

5 YOU KNOW WHO YOU ARE, WHO WORK WITH US TO MAKE THINGS HAPPEN, 

6 TO MAKE L.A. COUNTY A PLACE REALLY THAT WHEN I TRAVEL TO OTHER 

7 PLACES AND THEY INVITE ME TO TALK ABOUT WHAT'S GOING ON HERE, 

8 WE DON'T REALIZE IT HERE, BUT THEY REALLY SEE US AS AN 

9 EXAMPLE, AS A COUNTY THAT'S ON THE CUTTING EDGE THAT IS REALLY 

10 DEALING WITH ISSUES THAT THEY ARE NOW FACING AND WILL BE 

11 FACING IN THE COMING YEARS. SO I THINK IT'S REALLY A TRIBUTE 

12 TO THIS BOARD, TO THIS COUNTY THAT WE RECEIVE THIS RECOGNITION 

13 FROM THE STATE DEPARTMENT OF FAIR EMPLOYMENT AND HOUSING SO 

14 THANK YOU FOR THAT. [APPLAUSE.] 

15

16 SUP. ANTONOVICH: NOW WE WOULD LIKE TO BRING UP DANNY UBARIO 

17 FROM THE LANCASTER SHELTER AND MARCIA MAYEDA, OUR DIRECTOR OF 

18 ANIMAL CONTROL AND NANCY, DANNY'S WIFE, BECAUSE DANNY WAS 

19 NEWLY APPOINTED LANCASTER ANIMAL SHELTER MANAGER. AND WORKING 

20 WITH THE COUNTY DEPARTMENT FOR THE ANIMAL CARE AND CONTROL FOR 

21 THE PAST 10 YEARS, HE JOINED THE DEPARTMENT BACK IN SEPTEMBER 

22 1999 AS A KENNEL ATTENDANT AFTER COMPLETING A TOUR OF DUTY 

23 WITH THE UNITED STATES MARINE CORPS. HE WORKED IN FOUR OF OUR 

24 DEPARTMENT'S SIX SHELTERS. HE'S BEEN PROMOTED THROUGHOUT HIS 

25 YEARS AND SERVED AS THE ACTING SERVICE MANAGER BOTH AT 
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1 CARSON'S ANIMAL SHELTER AND LANCASTER ANIMAL SHELTER. PROMOTED 

2 TO HIS CURRENT ASSIGNMENT FOR THE LANCASTER SHELTER IN 

3 NOVEMBER 2009 AND HE'S BEEN A VERY PRODUCTIVE MANAGER. IN 

4 ADDITION TO SUCCESSFULLY MANAGING THE LANCASTER SHELTER AS 

5 WELL AS THE FIRST ADOPTION CENTER, THE ANTELOPE VALLEY PET 

6 STOP, DANNY'S ASSISTED IN THE IMPLEMENTATION OF A VERY 

7 AGGRESSIVE DOG TASKFORCE WHICH PROTECTIVELY TARGETS AND 

8 REMOVES DANGEROUS DOGS AT LARGE IN THE CITY OF LANCASTER AND 

9 THE NEARBY UNINCORPORATED AREAS. HE'S BEEN VERY SUCCESSFUL BY 

10 IMPOUNDING MORE THAN 1,000 DOGS, CREATING A SAFER COMMUNITY 

11 ENVIRONMENT FOR THE AREA RESIDENTS AND HIS DEDICATION TO THE 

12 LANCASTER ANIMAL SHELTER RECENTLY EARNED HIM THE KEY TO THE 

13 CITY OF LANCASTER, WHICH WAS PRESENTED TO DANNY THIS PAST WEEK 

14 WHEN I MET WITH THEM FOR MY REGULAR MEETINGS WITH THEM, MY 

15 CITY COUNCILS, AND DANNY WAS GIVEN THAT KEY TO THE CITY. AND 

16 THEY HAD A VERY SEVERE PROBLEM WITH PIT BULLS RUNNING WILD. 

17 AND THROUGH DANNY'S PROGRESSIVE LEADERSHIP, EFFECTIVE 

18 LEADERSHIP, THEY HAVE REMOVED OVER 1,000, I BELIEVE, FROM THE 

19 STREETS. HE'LL GIVE YOU THAT. AND THEN ESTABLISHED ONE OF THE 

20 MOST SUCCESSFUL PET ADOPTION CENTERS. BECAUSE THEY WERE 

21 GETTING SO MANY DOGS THAT THEY DIDN'T HAVE ROOM IN THE 

22 SHELTER, SO HE GOT ANOTHER FACILITY. AND IN THAT WE'VE HAD A 

23 VERY SUCCESSFUL PET ADOPTION PROGRAM. SO, DANIEL, 

24 CONGRATULATIONS. [APPLAUSE.] GIVE THEM THE STATISTICS ON THE 

25 PIT BULLS. 
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1

2 DANIEL UBARIO: I SENT THIS REPORT LAST WEEK WHEN WE HAD TO DO 

3 A BREAKFAST WITH THE CITY OF LANCASTER. AND AT THE BREAKFAST, 

4 I SAID "I'VE SAID THIS REPORT SO MANY TIMES I KNOW IT BY 

5 HEART." LAST YEAR, WE IMPOUNDED 1,038 PIT BULLS AND 650 

6 ROTTWEILERS JUST IN THE CITY OF LANCASTER. IN THE COUNTY OF 

7 LANCASTER OR THE UNINCORPORATED AREA OF LANCASTER, WE 

8 IMPOUNDED 658 PIT BULLS ALONE. SO THIS IS A COMMENDABLE FEAT, 

9 DONE BY MY STAFF LAST WEEK WHEN THE BREAKFAST OPENED UP IN 

10 LANCASTER, SUPERVISOR ANTONOVICH, SOMETHING THAT'S VERY, VERY 

11 TRUE, HE SAID, "YOU'RE ONLY AS GOOD AS YOUR STAFF IS." AND 

12 THIS AWARD IS NOT ONLY SOMETHING THAT I CHERISH TO HEART, BUT 

13 THAT I WANT TO SHARE WITH MY STAFF. MY STAFF IS OBVIOUSLY NOT 

14 HERE BECAUSE THEY'RE RUNNING THE SHELTER UP NORTH. BUT I 

15 REALLY WANT TO TAKE A MOMENT TO COMMEND MY STAFF FOR REALLY 

16 GIVING ME THE SUPPORT I NEED. I WANT TO THANK SUPERVISOR 

17 ANTONOVICH FOR GIVING MY DEPARTMENT ALL THE SUPPORT THAT IS 

18 NEEDED UP NORTH. AND I WANT TO THANK MARCIA AND DEREK FOR 

19 THEIR RELENTLESS SUPPORT TO ME. I WANT TO THANK MY WIFE FOR 

20 PUTTING UP WITH ME IN ALL THE TIMES I WAS FRUSTRATED AND THE 

21 ONLY PERSON I COULD VENT WITH WAS TO HER. YOU KNOW, IT TAKES A 

22 VERY, VERY PATIENT WOMAN TO HEAR ME OUT, I CAN TELL YOU THAT 

23 MUCH, BECAUSE I'M VERY ARGUMENTATIVE. BUT I REALLY WANT TO 

24 THANK THE BOARD OF SUPERVISORS AND MY DEPARTMENT FOR REALLY 
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1 SUPPORTING ME IN GETTING THIS FEAT ACCOMPLISHED. THANK YOU. 

2 [APPLAUSE.] 

3

4 MARCIA MAYEDA: I'D JUST LIKE TO THANK SUPERVISOR ANTONOVICH 

5 FOR THIS RECOGNITION. IT'S BEEN A LOT OF WORK AND DANNY HAS 

6 DONE A TREMENDOUS JOB, ALONG WITH HIS STAFF. AND IT'S BEEN 

7 VERY REWARDING TO THE PEOPLE IN THE COUNTY UP THERE. WE HAVE A 

8 SAFER COMMUNITY NOW. AND WE JUST APPRECIATE THE RECOGNITION. 

9 I'D LIKE TO CONGRATULATE DANNY ON ALL HIS HARD WORK. THANK 

10 YOU. [APPLAUSE.] 

11

12 SPEAKER: THANK YOU, SUPERVISOR ANTONOVICH. AS DANNY SAID, IT 

13 REALLY HAS BEEN A GROUP EFFORT. ALL THE STAFF COMBINED 

14 TOGETHER HAS ACCOMPLISHED THE COMMENDABLE RESULTS THAT WE'VE 

15 ACHIEVED UP THERE IN THE ANTELOPE VALLEY. SO, AGAIN, THANK 

16 YOU. [APPLAUSE.] 

17

18 SUP. MOLINA, CHAIR: CONGRATULATIONS. 

19

20 SUP. ANTONOVICH: DANNY LIVES IN WEST COVINA, SO HE HAS A 

21 LITTLE DRIVE EVERY MORNING UP TO THE ANTELOPE VALLEY. BUT HE 

22 ALWAYS GOES AGAINST TRAFFIC, SO THAT'S GOOD. OKAY, NOW WE HAVE 

23 A LITTLE 52-WEEK OLD FEMALE POMERANIAN, TRIXIE. THIS IS LITTLE 

24 TRIXIE LOOKING FOR A HOME. ANYBODY LIKE TO ADOPT TRIXIE, YOU 

25 CAN CALL 562-728-4644 OR ANYBODY IN THE AUDIENCE WOULD LIKE 
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1 LITTLE TRIXIE? ANYBODY YOU SEE? CUTE LITTLE DOG. HOW ABOUT 

2 YOU, BILL? USUALLY COUNTY COUNSEL'S ADOPT AT LEAST A COUPLE A 

3 YEAR. HOW ABOUT YOU, STEVE? NO? [LAUGHTER.] OKAY. THIS IS 

4 LITTLE TRIXIE, ONE YEAR OLD. 

5

6 SUP. MOLINA, CHAIR: VERY GOOD. THANK YOU. I HAVE ONE MORE 

7 PRESENTATION. I'M GOING TO ASK MANUEL MORENO TO JOIN US. HOW 

8 DO YOU DO? WELL, I WAS ASKED TO MAKE THIS PRESENTATION, AND OF 

9 COURSE I SAID, "WHO THE HECK IS MANUEL MORENO?" LET ME TELL 

10 YOU AND SHARE WITH YOU WHO MANUEL MORENO IS. HE WORKS RIGHT 

11 HERE. HE IS A RESEARCH DIRECTOR IN THE C.E.O.'S OFFICE FOR THE 

12 SERVICE INTEGRATION BRANCH. AND THE REASON WE'RE HONORING HIM 

13 TODAY IS BECAUSE HE HAS RECEIVED A VERY, VERY SPECIAL KIND OF 

14 RECOGNITION. HE HAS BEEN RECOGNIZED BY COMPUTERWORLD MAGAZINE 

15 AS THE 2010 PREMIER 100 INFORMATION TECHNOLOGY LEADERS. THAT'S 

16 PRETTY IMPRESSIVE, MANUEL. AND SO CONGRATULATIONS THAT ONE OF 

17 OUR VERY OWN HAS MADE IT TO THE LIST OF 100. WHEN YOU TALK 

18 ABOUT THE TECHNOLOGY WORLD AND WHAT IS BEING DONE IN THIS 

19 COUNTRY AS FAR AS THE ADVANCEMENT IN TECHNOLOGY, TO HAVE ONE 

20 OF OUR VERY OWN PEOPLE RECOGNIZED AS ONE OF THESE 100, IT'S 

21 PRETTY UNIQUE AND VERY SPECIAL. THIS PRESTIGIOUS AWARD 

22 RECOGNIZES EXCEPTIONAL TECHNOLOGY LEADERS FROM A BROAD RANGE 

23 OF COMPANIES AND ORGANIZATIONS THROUGHOUT THE COUNTRY. AT THE 

24 C.E.O.'S OFFICE, MANUEL HAS ESTABLISHED CREATIVE WORK 

25 ENVIRONMENTS, INSTITUTED INNOVATIVE APPROACHES TO INFORMATION 
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1 TECHNOLOGY CHALLENGES, OF WHICH THERE ARE MANY IN THIS COUNTY, 

2 I THINK WE WOULD ALL AGREE, RIGHT, MANUEL? BUT HE HAS BEEN 

3 ABLE TO PUT TOGETHER THOSE KINDS OF CHALLENGES AND MEETING 

4 THOSE CHALLENGES AND HAS EFFECTIVELY MANAGED MANY OF THOSE 

5 CHALLENGES AS WELL AS CREATED SOLUTIONS AND STRATEGIES FOR THE 

6 COMPLEXITY OF THOSE PROBLEMS. UNDER MANUEL'S DIRECTION, THE 

7 FIRST UNITED DATA WAREHOUSE FOR THE COUNTY'S SOCIAL SERVICE 

8 DEPARTMENTS WERE CREATED. THE ADULT LINKAGES PROJECT BROUGHT 

9 TOGETHER VARIOUS COUNTY DEPARTMENTS TO EXAMINE THE UTILIZATION 

10 OF CLIENT SERVICES. NOW, THIS IS VERY SIGNIFICANT AND VERY 

11 IMPORTANT BECAUSE IT ENABLED US TO IDENTIFY THE FREQUENT USERS 

12 AND ANALYZE NOT ONLY HOW FUNDS WERE SPENT, BUT ALSO HOW PEOPLE 

13 ARE UTILIZING OUR SYSTEM. ALSO, MANUEL RECENTLY ESTABLISHED A 

14 NEW DATA MINING SYSTEM TO HELP PREVENT CHILDCARE FRAUD AT THE 

15 CALWORKS PROGRAM. THESE ARE VERY INNOVATIVE PROGRAMS, AND THEY 

16 HAVE GONE A LONG WAY TO IMPROVE THE NOT ONLY THE DELIVERY OF 

17 SOCIAL SERVICES, MORE SIGNIFICANTLY AS TO OUR RELATIONSHIP 

18 WITH OUR CLIENTS IN MAKING SURE WE ARE CARRYING OUT THIS WORK. 

19 IT IS QUITE AN AWARD. IT IS PRETTY IMPRESSIVE. HE'S VERY PROUD 

20 OF IT. AND HE HAS BROUGHT ALONG TODAY HIS SON GABRIEL, HIS 

21 MANAGER, KATHY HOUSE, AND HIS COLLEAGUE IS IT HALI TORO AND 

22 MARK STEVENS. WELL ALL OF THEM IN CELEBRATION FOR AN 

23 OUTSTANDING JOB. WE'RE VERY PROUD OF YOU, MANUEL. 

24 CONGRATULATIONS. VERY DESERVING. LET ME MAKE THIS 

25 PRESENTATION. LET'S TAKE A PICTURE AND THEN I'D LIKE YOU TO 
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1 SHARE A FEW WORDS WITH US. [APPLAUSE.] WELL, MANUEL, SHARE A 

2 FEW WORDS WITH US. TELL US WHAT YOU'VE BEEN DOING THERE 

3 QUIETLY WITHOUT US NOTICING BUT VERY FRANKLY CHAMPIONING 

4 TREMENDOUS EFFORTS ON OUR PART. 

5

6 MANUEL MORENO: IT IS A GREAT HONOR FOR ME TO BE HERE TODAY. 

7 I'D LIKE TO THANK SUPERVISOR MOLINA FOR THE RECOGNITION. THE 

8 AWARD FROM COMPUTERWORLD IS THE END RESULT OF A COLLABORATIVE 

9 PROJECT THAT BEGAN IN 2006 TO IMPLEMENT THE LINKAGE 

10 ACKNOWLEDGES PROJECT, WHICH WAS A PROJECT TO LINK SOCIAL 

11 SERVICES INFORMATION ACROSS DIFFERENT COUNTY DEPARTMENTS. THE 

12 PURPOSE OF THIS PROJECT WAS TO PROVIDE THE BOARD AND COUNTY 

13 MANAGERS WITH INFORMATION THAT COULD BE USED TO ENHANCE VITAL 

14 PROGRAMS IN WAYS THAT WILL AT ONCE MAKE THEM MORE COST-

15 EFFECTIVE FOR THE PEOPLE OF THE COUNTY AND MORE COST-EFFECTIVE 

16 IN USE OF OUR SCARCE DOLLARS. I WOULD LIKE TO THANK ALL OF MY 

17 CO-WORKERS AT THE C.E.O. I WOULD ALSO LIKE TO EXTEND MY THANKS 

18 TO PHIL ANSELL AT THE DEPARTMENT OF SOCIAL SERVICES FOR THE 

19 SUPPORT PROVIDED IN THIS PROJECT. I WOULD ALSO BE REMISS IF I 

20 DIDN'T ACKNOWLEDGE THE GREAT SUPPORT THAT WAS PROVIDED BY OUR 

21 FORMER DEPUTY C.E.O. MIGUEL SANTADA FOR THIS PROJECT. I WOULD 

22 ALSO LIKE TO ACKNOWLEDGE THE SUPPORT OF OUR ACTING DEPUTY 

23 C.E.O., KATHY HOUSE, ON THIS PROJECT, AND OUR S.I.B. ACTING 

24 BRANCH MANAGER, LESLIE GLAZIER. ADDITIONALLY, I WANT TO THANK 

25 THE DEPARTMENTAL DIRECTORS OF ALL THE AGENCIES IN THE COUNTY 
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1 THAT COLLABORATED WITH THIS PROJECT. THE DIRECTOR OF SOCIAL 

2 SERVICES, MENTAL HEALTH, PUBLIC HEALTH, THE PROBATION 

3 DEPARTMENT, FAMILY SERVICES, SENIOR SERVICES AND THE SHERIFF 

4 FOR GIVING US THEIR SUPPORT. THANK YOU, SUPERVISOR MOLINA, 

5 ONCE AGAIN. 

6

7 SUP. MOLINA, CHAIR" CONGRATULATIONS. [APPLAUSE.] LET'S EXPRESS 

8 OUR GRATITUDE MOST IMPORTANTLY IN WORKING FOR US TO MAKE US 

9 LOOK SO GOOD. CONGRATULATIONS. [APPLAUSE.] ALL RIGHT. THAT 

10 CONCLUDES OUR PRESENTATIONS. I GUESS FIRST UP WOULD HAVE BEEN 

11 SUPERVISOR RIDLEY-THOMAS? CORRECT? 

12

13 >>CLERK SACHI HAMAI: WE ALSO HAVE PUBLIC HEARINGS TODAY. 

14

15 SUP. MOLINA, CHAIR: WHY DON'T WE BEGIN WITH THAT BEFORE WE GO 

16 ON TO OUR SPECIALS. SO IF YOU'D SWEAR EVERYBODY IN? 

17

18 CLERK SACHI HAMAI: ON ITEMS NO. 1 AND 2, ALL THOSE WHO PLAN TO 

19 TESTIFY BEFORE THE BOARD, PLEASE STAND AND RAISE YOUR RIGHT 

20 HAND TO BE SWORN IN? I DON'T BELIEVE WE HAVE ANYONE. 

21

22 SUP. MOLINA, CHAIR: IS THERE ANYONE STANDING? I DON'T BELIEVE 

23 THERE IS ANYONE. 

24
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1 CLERK SACHI HAMAI: THERE IS NOT. ITEM NO. 1 I WILL READ THE 

2 SHORT TITLE IN FOR THE RECORD. THIS IS THE HEARING ON THE 

3 ISSUANCE, SALE AND DELIVERY OF ONE OR MORE SERIES OF SINGLE-

4 FAMILY MORTGAGE REVENUE BONDS BY THE SOUTHERN CALIFORNIA HOME 

5 FINANCING AUTHORITY IN THE AGGREGATE PRINCIPAL AMOUNT NOT TO 

6 EXCEED $500 MILLION OVER A THREE-YEAR PERIOD TO PROVIDE 

7 FINANCING FOR ITS FIRST-TIME HOME BUYER PROGRAMS. NO 

8 CORRESPONDENCE WAS RECEIVED. THERE IS NO DEPARTMENT STATEMENT. 

9 THIS ITEM IS BEFORE YOUR BOARD. 

10

11 SUP. MOLINA, CHAIR: ALL RIGHT. SO WOULD IT BE APPROPRIATE FOR 

12 US TO CLOSE THE PUBLIC HEARING AND TO HAVE THAT ITEM MOVED? 

13 MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR 

14 YAROSLAVSKY. IF THERE IS NO OBJECTION, SO ORDERED ON THAT 

15 ITEM. ITEM NO. 1. 

16

17 CLERK SACHI HAMAI: ON ITEM NO. 2, THIS IS THE COMBINED HEARING 

18 ON PROJECT NO. T.R.063243-2 GENERAL PLAN AMENDMENT CASE NO. 

19 2005-00011-2. ZONE CHANGE CASE NO. 2005- 00022-2. CONDITIONAL 

20 USE PERMIT CASE NO. 2005-00236-2. VESTING TENTATIVE TRACK MAP 

21 CASE NO. 063243-2 AND ENVIRONMENTAL ASSESSMENT CASE NO. 2005-

22 00207-2. AND NEGATIVE DECLARATION RELATING TO PROPERTY LOCATED 

23 AT 1028 WEST 223RD STREET WITHIN THE UNINCORPORATED COMMUNITY 

24 OF WEST CARSON, CARSON ZONE DISTRICT, PETITIONED BY MR. LLOYD 
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1 ANASTASI. AND ON THIS ITEM, NO CORRESPONDENCE WAS RECEIVED. 

2 BUT THERE IS A DEPARTMENT STATEMENT. 

3

4 SUP. MOLINA, CHAIR: ALL RIGHT. IF WE COULD HAVE THE DEPARTMENT 

5 REPORT. 

6

7 JODY SACKET: MADAME CHAIR AND MEMBERS OF THE BOARD, MY NAME IS 

8 JODY SACKET AND I'M A SENIOR REGIONAL PLANNING ASSISTANT WITH 

9 THE LOS ANGELES COUNTY DEPARTMENT OF REGIONAL PLANNING. SEATED 

10 HERE WITH ME TODAY ARE MR. RICHARD BRECKNER, DIRECTOR OF 

11 REGIONAL PLANNING, DENNIS HUNTER, ASSISTANT DEPUTY DIRECTOR 

12 WITH THE L.A. COUNTY DEPARTMENT OF PUBLIC WORKS AND SOREN 

13 ALEXANIAN, DEPUTY DIRECTOR OF REGIONAL PLANNING. ITEM NO. 2 ON 

14 TODAY'S AGENDA IS A NEW PROPOSED 19-UNIT TOWNHOME CONDOMINIUM 

15 DEVELOPMENT IN THE UNINCORPORATED COMMUNITY OF WEST CARSON, 

16 LOCATED AT 1028 WEST 223RD STREET MIDWAY BETWEEN VERMONT AND 

17 NORMANDIE AND APPROXIMATELY A QUARTER MILE SOUTH OF THE HARBOR 

18 U.C.L.A. MEDICAL CENTER. NEARBY CITIES INCLUDE CARSON TO THE 

19 EAST, ACROSS THE 110 FREEWAY, AND LOS ANGELES TO THE WEST 

20 ACROSS NORMANDIE. ON JUNE 10TH, 2009, THE LOS ANGELES COUNTY 

21 REGIONAL PLANNING COMMISSION BY A VOTE OF 5-0 IN FAVOR 

22 RECOMMENDED APPROVAL OF THIS PROJECT TO YOUR BOARD. ABOVE ALL, 

23 FINDINGS OF APPROVAL ARE BASED ON THE PROJECT'S CONSISTENCY 

24 WITH THE LOS ANGELES COUNTY GENERAL PLAN. THE NEW MULTI-FAMILY 

25 RESIDENTIAL DEVELOPMENT WILL HELP IMPLEMENT THE URBAN 
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1 REVITALIZATION GOALS OF THE GENERAL PLAN WHICH CALLS FOR 

2 INFILLING OF ALREADY URBANIZED AREAS AND THE CONVERTING OF 

3 OLDER USES TO HIGHER DENSITIES. THE DEVELOPMENT WILL ALSO ADD 

4 MUCH NEEDED HOUSING WITHIN A CLOSE WALKING DISTANCE OF NEARBY 

5 USES SUCH AS THE MILER STREET ELEMENTARY SCHOOL, THE 

6 CORNERSTONE CHRISTIAN CHURCH AND CENTER, THE ZION LUTHERAN 

7 CHURCH AND SCHOOL AND ALREADY MENTIONED HARBOR U.C.L.A. 

8 MEDICAL CENTER. ALSO WITHIN A CONVENIENT QUARTER MILE WALKING 

9 DISTANCE ARE TWO SMALL LOCAL GROCERY STORES AND AN M.T.A. BUS 

10 STOP ON VERMONT WITH LOCAL SERVICE TO THE NEARBY HARBOR 

11 U.C.L.A. THE THREE STORY DEVELOPMENT HAS THREE BEDROOM UNITS, 

12 AN ON SITE PLAY AREA AND SUFFICIENT OFF STREET PARKING 

13 SUITABLE FOR FAMILIES LOOKING FOR NEWER HOMES IN THE 

14 COMMUNITY. THESE NEW MULTI-FAMILY HOMES WILL NOT ONLY HELP 

15 INCREASE THE QUALITY OF LIFE FOR FUTURE RESIDENTS BY LOCATING 

16 NEW HOUSING NEAR EXISTING JOBS, SCHOOLS AND OTHER KEY 

17 DESTINATIONS, REDUCING AUTOMOBILE USE AND COMMUTE TIMES, BUT 

18 WILL ALSO HELP IMPLEMENT THE ENVIRONMENTAL CONSERVATION GOALS 

19 OF THE GENERAL PLAN TO IMPROVE OLDER EXISTING NEIGHBORHOODS 

20 AND LIMIT EXPANDING DEVELOPMENT ON THE FRINGES OF L.A. COUNTY. 

21 IN LIGHT OF THESE FACTS, STAFF RECOMMENDS THAT YOUR BOARD 

22 ADOPT THE NEGATIVE DECLARATION AND APPROVE PROJECT 063243-2 

23 CONSISTING OF THE ASSOCIATED GENERAL PLAN AMENDMENT 2005- 

24 00011, ZONE CHANGE 2005-00022, AND ADDITIONAL USE PERMIT 2005-
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1 00236, AND TENTATIVE TRACT MAP NO. 063243. THIS CONCLUDES 

2 STAFF'S PRESENTATION. THANK YOU. 

3

4 SUP. ANTONOVICH: MOVE THE ITEM. 

5

6 SUP. MOLINA, CHAIR: ALL RIGHT. WE WILL CLOSE THE PUBLIC 

7 HEARING THAT ITEM IS MOVED BY SUPERVISOR ANTONOVICH. SECONDED 

8 BY SUPERVISOR YAROSLAVSKY. IF THERE IS NO OBJECTION, SO 

9 ORDERED. THANK YOU SO MUCH FOR YOUR REPORT. 

10

11 JODY SACKET: THANK YOU. 

12

13 CLERK SACHI HAMAI: AND MADAME CHAIR, THAT COMPLETES THE PUBLIC 

14 HEARINGS FOR TODAY. 

15

16 SUP. MOLINA, CHAIR: VERY GOOD. ALL RIGHT. THEN I AM GOING TO 

17 TURN IT OVER TO SUPERVISOR YAROSLAVSKY FOR HIS SPECIALS. 

18

19 SUP. YAROSLAVSKY: MADAME CHAIR, IF I CAN FIND HERE-- ON ITEM 

20 NO. 3, IF I COULD JUST ASK THAT-- MY STAFF HAS CHECKED WITH 

21 MR. RIDLEY-THOMAS'S STAFF AND THEY'RE OKAY WITH THIS. CAN WE 

22 GET ONE REPORT BACK IN 60 TO 90 DAYS INSTEAD OF A BIWEEKLY 

23 REPORT? IT WILL MAKE IT EASIER FOR EVERYBODY. CLARIFICATION. 

24 THE AUTHOR OF THE MOTION IS OKAY WITH THAT. AND I DON'T HAVE 

25 ANY ADJOURNING MOTIONS OR ANY OTHER ITEMS. 
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1

2 SUP. MOLINA, CHAIR: ALL RIGHT. SUPERVISOR ANTONOVICH, YOUR 

3 SPECIALS? 

4

5 SUP. ANTONOVICH: I'D LIKE TO ADJOURN TODAY IN THE MEMORY OF 

6 AMERIO CORRADI [OFF MIC.] PASSED AWAY AT THE AGE OF 87. HE AND 

7 HIS COMPANY [INAUDIBLE] WORLD WAR II. [INAUDIBLE] 

8

9 SPEAKER: LOUDER! 

10

11 SUP. ANTONOVICH: [INAUDIBLE] BEFORE BEING SOLD TO CAMPBELL 

12 SOUP/PEPPERIDGE FARMS. 

13

14 CLERK SACHI HAMAI: IT'S ON. 

15

16 SUP. ANTONOVICH: ARCHIE KIDWELL, RESIDENT OF SAN FERNANDO 

17 VALLEY, ATTENDED THE UNIVERSITY OF SOUTHERN CALIFORNIA, SERVED 

18 IN THE UNITED STATES AIR FORCE. DURING HIS 41 CAREER WITH THE 

19 AUTO CLUB BECAME DISTRICT MANAGER OF A NUMBER OF OFFICES 

20 THROUGHOUT SOUTHERN CALIFORNIA AND WAS A ROTARIAN FOR 36 YEARS 

21 AND HONORED AS A PAUL HARRIS FELLOW. BETTY JEANNE HOWELL 

22 PASSED AWAY AT THE AGE OF 85, MEMBER OF OUR SAVIOR LUTHERAN 

23 CHURCH AND A COMPANY SEAMSTRESS. LIVED IN ANTELOPE VALLEY FOR 

24 41 YEARS. GEORGE DE GREAVE, LONG TIME RESIDENT OF THE ANTELOPE 

25 VALLEY, VETERAN OF WORLD WAR II, WAS A CAREER WITH THE DEPUTY 
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1 SHERIFF OF LOS ANGELES COUNTY SHERIFF'S DEPARTMENT WHEN HE 

2 RETIRED IN 1980. MARK JUSTIN DARRINGTON, KOREAN WAR VETERAN, 

3 EDUCATOR, MUSICIAN, CHORAL DIRECTOR, AND BUSINESSMAN. GEORGIA 

4 LOUISE KNIGHT, RESIDENT OF ANTELOPE VALLEY. SHE WAS THE 

5 COORDINATOR OF THE L.A. COUNTY LITERACY PROGRAM THROUGH THE 

6 QUARTZ HILL PUBLIC LIBRARY AND HER EFFORTS WERE INSTRUMENTAL 

7 IN ASSISTING ANTELOPE VALLEY RESIDENTS TO IMPROVE THEIR 

8 READING, WRITING AND LANGUAGE SKILLS. DR. JESSICA KORN, WHO 

9 WAS THE DAUGHTER OF CAROLBETH AND LESTER, SISTER OF JODI, ROB 

10 AND SLOANE. VIRGILIO MAGSOMBOL PASSED AWAY AT THE AGE OF 66. 

11 SHE WAS THE NURSING SUPERVISOR FOR THE L.A. COUNTY SHERIFF'S 

12 DEPARTMENT WHERE SHE SERVED FOR THE PAST 36 YEARS. THE LAST 

13 ASSIGNMENT WAS TO THE MEDICAL SERVICES. JEAN MOORE, ALSO A 

14 RESIDENT OF ANTELOPE VALLEY. AND ROBERT TURTURICE WHO WAS A 

15 FORMER PRESIDENT OF THE COSTUME DESIGNERS GUILD, WHO WON THE 

16 EMMY WARD FOR HIS WORK ON THE 1980S T.V. SERIES "MOONLIGHTING" 

17 AS WELL AS THE BEST DRESSED SERIES AWARD FROM THE CALIFORNIA 

18 FASHION DESIGN. JOANNE VICTORIA WOOLWORTH. SHE OPENED JOANIE'S 

19 COFFEE SHOP IN QUARTZ HILL WITH THE HELP OF HER DAUGHTERS 

20 CHERRY AND MARIAN AND SONS MARK AND EDDIE. MARIAN FORST 

21 BISHOP, SANTA CLARITA VALLEY. SHE WAS AN EDUCATOR FOR THE 

22 SAUGUS UNION SCHOOL DISTRICT AND VOLUNTEER FOR MANY OF OUR 

23 LOCAL CHARITIES. HELMUT BRANDNER, WHO WAS A RESIDENT OF-- 

24 GRADUATED FROM BURBANK HIGH SCHOOL, LIVED IN ANTELOPE VALLEY 

25 FOR OVER 50 YEARS WHERE HE WAS EMPLOYED WITH THE AEROSPACE 
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1 INDUSTRY WITH BOEING, MCDONNELL-DOUGLAS AND LOCKHEED. THOSE 

2 ARE MY ADJOURNMENTS. 

3

4 SUP. MOLINA, CHAIR: SO ORDERED ON THAT ADJOURNMENT. 

5

6 SUP. ANTONOVICH: AND I WOULD LIKE TO INTRODUCE THE FOLLOWING 

7 MOTIONS. JANUARY 14TH AND JANUARY 15TH, THE LANCASTER PAROLE 

8 OFFICE LOCATED AT 43645 PIONEER COURT WAS VANDALIZED WITH 

9 SPRAY PAINT. THE WORDS OR PHRASES SUCH AS "187 POLICE," "187 

10 SHERIFF, "CUM TO MY HOUSE AND YOU DIE." THE DEPARTMENT IS 

11 SEEKING PUBLIC ASSISTANCE IN THEIR INVESTIGATION OF THIS CRIME 

12 AND I WOULD MOVE THAT THE BOARD OFFER A $10,000 REWARD FOR 

13 INFORMATION THAT WOULD LEAD TO THE ARREST AND/OR CONVICTION 

14 FOR THOSE RESPONSIBLE FOR VANDALIZING THE LANCASTER PAROLE 

15 OFFICE LOCATED AT 43645 PIONEER COURT BETWEEN JANUARY 14TH AND 

16 JANUARY 15TH. SO MOVED. 

17

18 SUP. YAROSLAVSKY: SECOND. 

19

20 SUP. MOLINA, CHAIR: IT'S BEEN MOVED AND SECONDED. THIS IS A 

21 REWARD MOTION. SO I THINK IT'S APPROPRIATE. IF THERE'S NO 

22 OBJECTION, SO ORDERED ON THIS. 

23

24 SUP. ANTONOVICH: ASSEMBLY BILL 2131 WHICH IS THE CHILD WELFARE 

25 FUNDING, AUGUST 2009, GOVERNOR SCHWARZENEGGER UNILATERALLY CUT 
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1 $80 MILLION TO CHILD WELFARE PROGRAMS THROUGH THE STATE, 

2 PUTTING THOUSANDS OF FOSTER CHILDREN AND OTHER AT-RISK YOUTH 

3 IN SEVERE DANGER. THE TITLE IV-E WAIVER CONTINUED, COUNTIES 

4 RECEIVED $19 MILLION IN CUTS WHILE L.A. COUNTY WAS LOSING $17 

5 MILLION IN CHILD WELFARE FUNDING. THESE CUTS HAVE LEFT AN 

6 ALREADY SERIOUSLY UNDERFUNDED CHILD PROTECTION SYSTEM IN DIRE 

7 STRAITS. ON FEBRUARY 18TH, THE ASSEMBLY MEMBER KAREN BASS 

8 INTRODUCED ASSEMBLY BILL 2131 TO RESTORE THIS FUNDING FOR 

9 CHILD WELFARE SERVICES. AND I WOULD MOVE THAT THE BOARD 

10 SUPPORT THE ASSEMBLY BILL 2131, DIRECTING THE C.E.O. AND 

11 DEPARTMENT OF CHILDREN AND FAMILY SERVICES AND THE COUNTY 

12 WELFARE DIRECTOR'S ASSOCIATION THROUGH THEIR SUPPORT AND 

13 EFFORTS TO ENSURE PASSAGE OF THIS BILL. I DON'T KNOW IF WE CAN 

14 DO THAT TODAY OR IF THIS HAS TO BE NEXT WEEK. 

15

16 SUP. MOLINA, CHAIR: THERE IS NOBODY HERE TO TELL US. LET'S 

17 SEE. IT IS AN ACTION BILL, SO I THINK WE WOULD HAVE TO DO IT 

18 NEXT WEEK, IS THAT CORRECT? UNLESS THERE'S A SENSE OF URGENCY. 

19 I THINK ANDREA IS ON THE PHONE. I THINK WHAT WE'LL DO IS I 

20 THINK BECAUSE IT DOES ASK FOR SUPPORT, WHY DON'T WE JUST PUT 

21 IT ON THE AGENDA FOR NEXT WEEK? 

22

23 SUP. ANTONOVICH: OKAY. THAT'S FINE. CREATING A FOURTH CHILD 

24 WELFARE OUTCOME GOAL, SELF-SUFFICIENCY. SINCE 2003, THE 

25 DEPARTMENT OF CHILDREN AND FAMILY SERVICES HAS FOCUSED ON A 
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1 STRATEGICALLY IMPROVING OUTCOMES FOR CHILDREN AND FAMILIES. TO 

2 ACCOMPLISH THESE IMPROVEMENTS, THEY HAVE IDENTIFIED THREE 

3 OUTCOME GOALS: WHICH ARE IMPROVED SAFETY, IMPROVED PERMANENCY 

4 AND REDUCED RELIANCE ON OUT OF HOME CARE TO ACHIEVE THE 

5 DESIRED OUTCOMES, THEY'VE IMPLEMENTED A NUMBER OF SUCCESSFUL 

6 STRATEGIES, INCLUDING REALIGNMENT OF EXISTING DEPARTMENTAL 

7 REVENUES AND EXPENDITURES WITH THE DESIRED OUTCOMES; 

8 SIGNIFICANT SERVICE DELIVERY REFORMS; OUTCOME-BASED OUT 

9 CONTRACTING AND IMPROVED WORKING RELATIONSHIPS WITH OTHER 

10 COUNTY DEPARTMENTS; AND CHILD WELFARE STAKEHOLDERS. TO DATE, 

11 OUR WIDE SWEEPING REFORMS HAVE REALIZED IMPROVED CHILD SAFETY 

12 AND 18 PERCENT REDUCTION IN CASELOADS, 32 PERCENT IMPROVEMENT 

13 IN TIMELINES TO PERMANENCY, AND A 36 PERCENT REDUCTION IN 

14 CHILDREN LIVING IN OUT-OF-CARE HOMES. DESPITE THE SUCCESS 

15 BETWEEN 1,200 AND 1,500 YOUTH AGE OUT OF COUNTY SUPERVISION AT 

16 AGE 18. FOLLOWING YEARS IN AND OUT OF HOME CARE WITHOUT SELF-

17 REUNIFICATION OR ALTERNATIVE PERMANENCY, THESE YOUNG PEOPLE 

18 ARE IN DIRE NEED AND UNFORTUNATELY THEIR SPECIFIC NEEDS ARE 

19 NOT CONSISTENTLY AND COMPREHENSIVELY MET THROUGH THE EXISTING 

20 THREE OUTCOME GOALS. NATIONAL STATISTICS REVEAL THAT MANY OF 

21 THESE YOUTH AGE OUT WITH LOW EDUCATIONAL ATTAINMENT, IMMINENT 

22 HOUSING NEEDS, SUBSTANTIALLY LESS INCOME EARNING ABILITY AND 

23 OFTEN NO TRANSITION TO THE ADULT SYSTEM OF CARE NEEDED TO 

24 SUPPORT THEIR SPECIFIC NEEDS. FOR THESE YOUTH, WE NEED TO 

25 CREATE A FOURTH CHILD WELFARE OUTCOME, WHICH IS SELF-



February 23, 2010

30

1 SUFFICIENCY. OVER THE PAST DECADE, MANY STATE LEGISLATIVE 

2 EFFORTS HAVE BEEN AIMED AT IMPROVING THE LIVES OF AGING OUT 

3 FOSTER YOUTH, BUT THEY HAVE FAILED DUE TO COST. FORTUNATELY, 

4 SEVERAL OTHER SUCCESSFUL STATE AND FEDERAL LEGISLATIVE 

5 ADVANCES HAVE INCLUDED 1999 CHAFFE FOSTER CARE INDEPENDENT 

6 ACT, 2004 ASSEMBLY BILL 490, ENSURING EDUCATIONAL RIGHTS FOR 

7 FOSTER YOUTH, 2006 ASSEMBLY BILL 2985, PROTECTING YOUTH 

8 IDENTITY THEFT, AND 2008 H.R.6893 FOSTERING CONNECTIONS TO 

9 SUCCESS AND INCREASING ADOPTIONS ACT. IN OCTOBER 2008, 

10 PRESIDENT GEORGE W. BUSH SIGNED H.R.6893 INTO LAW. THIS IS 

11 LANDMARK FEDERAL LEGISLATION WITH MANDATORY REQUIREMENTS FOR 

12 STATES, ONE OF WHICH IS AN AGE EXTENSION FOR VOLUNTARY FOSTER 

13 CARE SERVICES BETWEEN THE AGES OF 18 AND 21. ACCORDING TO 

14 DECEMBER 2008 ASSEMBLY SPEAKER KAREN BASS AND ASSEMBLYMAN JIM 

15 BEALL, INTRODUCED ASSEMBLY BILL 12 TO ENSURE THAT CALIFORNIA 

16 OPTED TO THE MANDATORY REQUIREMENTS. JANUARY 2010, ASSEMBLY 

17 BILL 12 PASSED OUT OF THE ASSEMBLY AND IS NOW AWAITING 

18 HEARINGS BY THE STATE'S SENATE ON HUMAN SERVICES AND 

19 JUDICIARY. AS CURRENTLY DRAFTED, THE IMPLEMENTATION OF THE 

20 MANDATORY PROVISIONS WOULD BE PHASED IN BETWEEN JANUARY 1ST, 

21 2012 TO JANUARY 1ST, 2014. HOWEVER, OUR YOUTH CAN'T WAIT. WE 

22 HAVE TO WORK SMARTER BY ADDING A MEASURABLE FOURTH CHILD 

23 WELFARE OUTCOME GOAL, SELF-SUFFICIENCY, AND ACHIEVING BETTER 

24 SELF-SUFFICIENCY OUTCOMES BY YOUTH BY REALIGNING THE 

25 DEPARTMENTAL REVENUES AND EXPENDITURES. CURRENTLY PLANNING 
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1 YOUTH DEVELOPMENT SERVICES CONTRACTING OUTCOMES BASE SELF-

2 SUFFICIENCY SERVICES AND IMPROVING WORKING RELATIONSHIPS WITH 

3 OTHER COUNTY DEPARTMENTS AND CHILD WELFARE STAKEHOLDERS. NO 

4 EFFORT SHOULD BE SPARED TO ENSURE THE FUTURE SUCCESS OF EACH 

5 AND EVERY ONE OF OUR YOUNG PEOPLE AS PRODUCTIVE MEMBERS OF OUR 

6 SOCIETY. SO I'D MOVE THAT THE BOARD DIRECT THE C.E.O., IN 

7 CONJUNCTION WITH CHILDREN AND FAMILY SERVICES, PROBATION, 

8 PUBLIC SOCIAL SERVICES, COMMUNITY AND SENIOR SERVICES, MENTAL 

9 HEALTH, COMMUNITY DEVELOPMENT COMMISSION AND OTHER AFFECTED 

10 DEPARTMENTS TO REPORT BACK IN 30 DAYS AND QUARTERLY THEREAFTER 

11 ON ESTABLISHING THE FOURTH CHILD WELFARE OUTCOME GOAL OF SELF-

12 SUFFICIENCY AND THE FEASIBILITY OF REALIGNING EXISTING 

13 DEPARTMENTAL REVENUES AND EXPENDITURES TO SUPPORT NEW 

14 STRATEGIES, IMPROVING SELF-SUFFICIENCY FOR YOUTH, INCLUDING 

15 BUT NOT LIMITED TO HOUSING, EDUCATION, EMPLOYMENT, WELL-BEING. 

16 TWO, CENTRALIZING CONCURRENT YOUTH DEVELOPMENT PLANNING 

17 SERVICES. THREE, INTEGRATING YOUTH-CENTERED SELF-SUFFICIENCY 

18 SERVICES ACROSS COUNTY DEPARTMENTS TO CREATE SEAMLESS SERVICE 

19 DELIVERY AND ESTABLISHING YOUTH, SELF-SUFFICIENTLY MAP GOALS 

20 WITH THE RESPONSIBLE DEPARTMENTAL MANAGERS WITHIN THESE 

21 VARIOUS COUNTY DEPARTMENTS. CREATING AN EVALUATION MECHANISM 

22 TO ESTABLISH BASELINE DATA AND ANNUALLY MEASURE IMPROVEMENTS 

23 IN THE CHILD WELFARE GOAL SELF-SUFFICIENCY. 

24
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1 SUP. MOLINA, CHAIR: ALL RIGHT. THAT'S GOING TO HAVE TO BE FOR 

2 NEXT WEEK. 

3

4 SUP. ANTONOVICH: THE NEXT MOTION WOULD BE, SINCE 2009, STATION 

5 FIRE WHICH BURNED OVER 160,000 ACRES AND WATERSHEDS OF 29 

6 DEBRIS PROTECTION FACILITIES, SUCH AS DEBRIS BASINS AND INLETS 

7 AND FIVE RESERVOIRS, THE STATION FIRE COMPOUNDS THE IMPACTS 

8 FROM THE 2008 MEREK, SESNON AND SAYRE FIRES WHICH IMPACTED AN 

9 ADDITIONAL 10 DEBRIS PROTECTION BASINS AND NECESSITATED 

10 INSTALLATION OF THREE POST FIRE DEBRIS BAY AREAS. THE COUNTY 

11 FLOOD DEPARTMENT PROTECTION FACILITIES AND RESERVOIRS ARE THE 

12 FIRST LINE OF DEFENSE TO PROTECT THE COMMUNITIES BELOW THE 

13 BURN AREAS. THE SEDIMENT LOAD FROM THESE BURN WATERSHEDS ARE 

14 SIGNIFICANT FOR MANY YEARS UNTIL THE WATERSHEDS RECOVER. THE 

15 FEBRUARY 6TH STORM SEVERELY IMPACTED THE DEBRIS PROTECTION 

16 FACILITIES FROM LA CANADA FLINTRIDGE TO THE VENTURA COUNTY 

17 LINE WITH THE DEPOSITION OF NEARLY 1 MILLION CUBIC YARDS OF 

18 SEDIMENT. THESE FACILITIES NEED TO BE CLEANED OUT IMMEDIATELY, 

19 AND THEY ARE BEING DONE AS WE SPEAK. THE FLOOD DEPARTMENT, 

20 COUNTY FLOOD DEPARTMENT CONTROLS, HAVE SEVERAL SEDIMENT 

21 PLACEMENT SITES IN THE FIRE AREA, BUT THEY'RE QUICKLY REACHING 

22 THEIR CAPACITY. LOCAL LANDFILLS ARE ALTERNATIVE DEPOSITION 

23 SITES FOR THE SEDIMENT REMOVAL. SO WHAT I'M MOVING IS THAT THE 

24 BOARD, IN LIGHT OF THE CONDITIONS OF EXTREME DANGER TO THE 

25 COUNTY RESIDENTS' SAFETY AND PROPERTY CREATED BY THE WILDFIRES 
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1 AND RECENT WINTER STORMS, FACILITATE ANY IMMEDIATE NEEDS TO 

2 REMOVE DISASTER-RELATED DEBRIS, MATERIALS FROM OUR DEBRIS 

3 PROTECTION FACILITIES, I MOVE THAT THE BOARD DETERMINE, BASED 

4 ON THE JOINT RECOMMENDATION OF THE COUNTY LOCAL ENFORCEMENT 

5 AGENCY AND THE DEPARTMENT OF PUBLIC WORKS, CONSISTENT WITH THE 

6 JANUARY 21ST STATE PROCLAMATION OF A STATE OF EMERGENCY, THAT 

7 AN INCREASE IN THE MAXIMUM AMOUNT OF DAILY, WEEKLY TONNAGE 

8 ALLOWED BY THE C.U.P. FOR THE SUNSHINE CANYON IS NECESSARY TO 

9 APPROPRIATELY MANAGE THE OVERALL COUNTY WASTE STREAM FOR THE 

10 PROTECTION OF PUBLIC HEALTH AND SAFETY, DIRECTING THE 

11 DEPARTMENT OF PUBLIC WORKS TO GRANT A TEMPORARY EXEMPTION TO 

12 THE DAILY AND WEEKLY TONNAGE LIMITS AT THE SUNSHINE CANYON FOR 

13 A PERIOD OF 90 DAYS FROM THE DATE OF THE MOTION TO ALLOW THE 

14 LANDFILL OPERATOR TO ACCEPT, STOCKPILE OR USE LANDFILL COVER 

15 FOR OTHER BENEFICIAL PURPOSES UP TO 64,800 TONS PER WEEK. THE 

16 MATERIALS FROM THE COUNTY FLOOD CONTROL DISTRICT'S DEBRIS 

17 PROTECTION FACILITIES IN ACCORDANCE WITH THE LANDFILL LAND USE 

18 PERMIT REQUIREMENTS. THESE MATERIALS WILL NOT BE INCLUDED IN 

19 THE DAILY, WEEKLY TONNAGE LIMITS OTHERWISE REQUIRED BY THE 

20 LAND USE PERMIT. I REQUEST THE STATE DEPARTMENT RESOURCE 

21 RECOVERY RECYCLING AND OTHER LOCAL JURISDICTIONS TO ALSO GRANT 

22 A 90-DAY EXCEPTION TO THE DAILY AND WEEKLY LIMITS FOR 

23 ACCEPTING MATERIALS FROM THE FLOOD CONTROL DISTRICT DEBRIS 

24 PROTECTION FACILITIES AT THE SUNSHINE CANYON AND SCHOLL CANYON 

25 LANDFILL AND REQUEST CAL CYCLE-- RECYCLE AND LOCAL ENFORCEMENT 



February 23, 2010

34

1 AGENCIES AND JURISDICTIONS TO WAIVE THOSE RESTRICTIONS ON THE 

2 HOURS OF OPERATION FOR SUNSHINE CANYON AND SCHOLL CANYON 

3 LANDFILLS FOR 90 DAYS IN ACCORDANCE WITH APPLICABLE PERMITTING 

4 REQUIREMENTS IN THE EVENT THAT A 24-HOUR, 7 DAY A WEEK 

5 OPERATION IS REQUIRED AND GRANT A 90-DAY WAIVER OF ANY COUNTY 

6 FEES REQUIRED TO BE IMPOSED ON THE SUNSHINE CANYON LANDFILL 

7 FOR DISASTER RELATED DEBRIS MATERIAL MANAGED AT THE SITE, 

8 DIRECTING THE DIRECTOR OF PUBLIC WORKS TO ENSURE THAT THESE 

9 MATERIALS ARE BENEFICIALLY USED RATHER THAN DISPOSED OF FOR 

10 THE MAXIMUM EXTENT POSSIBLE. DIRECTING THE DEPARTMENT OF 

11 PUBLIC WORKS TO WORK WITH THE STATE TO WAIVE ANY APPLICABLE 

12 FEES ON DISASTER-RELATED MATERIALS MANAGED AT THE SUNSHINE 

13 CANYON, SCHOLL CANYON LANDFILLS FOR 90 DAYS TO ASSIST IN THE 

14 TIMELY PROTECTION OF COUNTY RESIDENTS AND ASKING OTHER LOCAL 

15 JURISDICTIONS TO ALSO WAIVE THEIR FEES FOR THE MANAGEMENT OF 

16 DISASTER-RELATED DEBRIS MATERIALS AND DIRECTING PUBLIC WORKS 

17 AND DIRECTOR OF PUBLIC HEALTH TO REPORT BACK TO THE BOARD 

18 WITHIN 90 DAYS REGARDING THE PROGRESS OF REMOVING THE 

19 DISASTER-RELATED DEBRIS MATERIALS FROM THE FLOOD CONTROL 

20 DISTRICTS TO THE PROTECTION FACILITIES AND THE NEED TO EXTEND 

21 THESE WAIVERS TO CONTINUE REMOVAL OF DISASTER-RELATED 

22 MATERIALS. SO WHAT WE'RE DOING IS ASKING FOR A 90-DAY 

23 EXTENSION TO ACCEPT THE DEBRIS. WE'RE EXPECTING ANOTHER STORM 

24 THIS WEEK AS YOU KNOW. SO I WOULD ASK THAT WE COULD APPROVE 

25 THIS MOTION TODAY BECAUSE OF URGENCY. 
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1

2 ANDREA ORDIN, COUNSEL: THERE IS NO QUESTION, SUPERVISOR, IT'S 

3 EXTRAORDINARILY IMPORTANT AND IT IS SOMETHING THAT NEEDS TO BE 

4 DONE. THERE IS PROBABLY-- YOU HAVE THE POWER TO DO IT TODAY 

5 EVEN WITH THREE OF YOU HERE AS LONG AS IT'S UNANIMOUS AND AS 

6 LONG AS IT CAME TO OUR ATTENTION WITHIN THE LAST 72 HOURS. AND 

7 THAT THE ACTION NEEDS TO BE TAKEN IMMEDIATELY. HOWEVER, I 

8 BELIEVE THERE IS SO MUCH COORDINATION ON THIS VERY COMPLEX 

9 MOTION, AND PARTICULARLY WITH THE CITY OF LOS ANGELES, THAT I 

10 WOULD LIKE TO SUGGEST, AS IMPORTANT AS IT IS, TO TAKE ACTION 

11 NOW AS SOON AS POSSIBLE, THAT IT BE PUT OVER JUST ONE MORE 

12 WEEK TO FINALLY COORDINATE SOME OF THE MOVING PIECES HERE. 

13 THIS IS A VERY COMPLEX MOTION. 

14

15 SUP. MOLINA, CHAIR: COULDN'T WE PUT IT IN AND GIVE YOU 

16 AUTHORIZATION SO THAT YOU COULD PUT IN PLACE THE COORDINATION? 

17 SO THAT, IN OTHER WORDS, AREN'T WE EXPECTING ANOTHER STORM 

18 THIS WEEKEND? 

19

20 SUP. ANTONOVICH: RIGHT. THIS WEDNESDAY, THURSDAY. YES, WE ARE 

21 EXPECTING ANOTHER. 

22

23 SUP. MOLINA, CHAIR: THE REASON I SAY THIS IS I DO UNDERSTAND 

24 HOW IMPORTANT THESE CATCH BASINS ARE AND I KNOW THERE ARE SOME 

25 TRICKY ISSUES WITH THE CITY AND SO ON AS FAR AS PERMITS AND 
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1 THINGS OF THAT SORT. BUT I'M WONDERING: SHOULD WE WAIT ANOTHER 

2 WEEK? OR SHOULD WE CREATE A MECHANISM AND AUTHORIZE YOU TO 

3 MOVE FORWARD? 

4

5 SUP. YAROSLAVSKY: CAN I JUST ON THAT POINT? 

6

7 SUP. MOLINA, CHAIR: SURE. 

8

9 SUP. YAROSLAVSKY: IS THERE SOMETHING THAT'S COMING? IS THERE A 

10 DEADLINE THAT'S APPROACHING NOW THAT WE NEED TO EXTEND IT? 

11 DON'T WE HAVE THE AUTHORITY TO DUMP THE SEDIMENT? 

12

13 SUP. ANTONOVICH: ASK THE DIRECTOR. 

14

15 SUP. MOLINA, CHAIR: I THOUGHT WE DIDN'T HAVE THE AUTHORITY. 

16

17 SUP. YAROSLAVSKY: WELL IT SAYS EXTEND. AND I WONDER DID WE 

18 NEVER HAVE THE AUTHORITY AND WE'RE ASKING IT FOR THE FIRST 

19 TIME? OR DID WE HAVE IT AND IT'S EXPIRING AND WE NEED TO 

20 EXTEND IT? WHAT IS THERE TO PREVENT YOU FOR THE NEXT WEEK OR 

21 TWO WEEKS TO CONTINUE DUMPING? 

22

23 SPEAKER: WE'RE NOT PREVENTED FROM BRINGING MATERIAL TO THE 

24 LANDFILL. IT'S A MATTER OF THE COST, SUPERVISOR, TO BRING THE 

25 MATERIAL THERE. THERE IS A TONNAGE CAP, AS WELL, THAT PREVENTS 
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1 US FROM BRINGING. UP TO A CERTAIN AMOUNT CAN BE BROUGHT THERE, 

2 AND WHAT THE MOTION PROPOSES TO DO IS TO TAKE A LOOK AT OUR 

3 FEES THAT WE COLLECT AND TO LOOK AT THAT TONNAGE AMOUNT AND TO 

4 INCREASE IT. 

5

6 SUP. YAROSLAVSKY: THE DAILY TONNAGE HAS BEEN IN EFFECT FOR 

7 YEARS. AND YOU HAVE BEEN EXCEEDING-- I ASSUME YOU HAVE BEEN 

8 EXCEEDING THE DAILY TONNAGE OR HAVE YOU NOT EXCEEDED THE DAILY 

9 TONNAGE DURING THE STORM PERIOD? 

10

11 SPEAKER: NO, WE HAVE NOT. WE HAVE BEEN USING FLOOD CONTROL 

12 DISTRICT PROPERTY THAT'S DESIGNATED FOR THIS PURPOSE. 

13

14 SUP. YAROSLAVSKY: SO YOU HAVEN'T BEEN DUMPING IN THESE 

15 LANDFILLS AT ALL? 

16

17 SPEAKER: THAT'S CORRECT. THE LANDFILL IS OUR LOWEST PRIORITY 

18 FOR USE. BUT WE'RE AT A POINT IN THE STORM SEASON AND IN THESE 

19 SITES THAT WE OWN AND OPERATE, THAT WE'RE COMING TO A POINT 

20 THAT WE NEED TO LOOK FOR OTHER ALTERNATIVES. 

21

22 SUP. YAROSLAVSKY: I THINK THAT ANSWERS MY QUESTION. BUT I HAVE 

23 ANOTHER QUESTION ON THE FEES. WHEN YOU'RE DONE WITH THIS OTHER 

24 THING-- 

25
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1 SUP. MOLINA, CHAIR: NO, I WAS ONLY TRYING TO FIND A MECHANISM. 

2 I UNDERSTAND THERE ARE OTHER ISSUES, BUT I JUST WOULD LIKE TO-

3 - IS THERE A WAY THAT WE COULD FORMULATE THIS MOTION SO THAT 

4 THE BOARD COULD CREATE THE AUTHORIZATION ONCE YOU DO ALL THE 

5 COORDINATION TO MOVE FORWARD? I GUESS THAT'S THE QUESTION I'M 

6 ASKING. 

7

8 ANDREA ORDIN, COUNSEL: THERE'S NO QUESTION ABOUT HAVING THE 

9 MOTION UNDER THE BROWN ACT. I THINK WE'RE CONTENT ON THAT 

10 PORTION OF IT. IT MAY BE THAT WITH JUST SOME TWEAKING OF THE 

11 LANGUAGE TO MAKE CLEAR THAT WE'RE DIRECTING A WAIVER INSOFAR 

12 AS WE HAVE THE POWER TO DIRECT A WAIVER. 

13

14 SUP. ANTONOVICH: IT'S ALL PART OF SUNSHINE. 

15

16 ANDREA ORDIN, COUNSEL: RIGHT. AND OUR PART, WE'RE DIRECTING 

17 THAT WAIVER. BUT A RECOGNITION THAT THE WAIVER WOULD NOT BE 

18 COMPLETE OR ENTIRELY EFFECTIVE UNTIL THE REMAINDER OF THE 

19 COORDINATION IS DONE WITH THE CITY. 

20

21 SUP. MOLINA, CHAIR: ALL RIGHT. THAT'S ONE THING. COULD YOU 

22 TWEAK THAT LANGUAGE SO THAT IT MIGHT SAY THAT? SO IT GIVES YOU 

23 THE AUTHORIZATION TO BEGIN THE PROCESS INSTEAD OF JUST WAITING 

24 UNTIL NEXT WEEK AND BEGINS THE PROCESS TO MOVE FORWARD. I 
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1 THINK YOU COULD PROBABLY DO THAT. SUPERVISOR YAROSLAVSKY, YOU 

2 HAD OTHER QUESTIONS? 

3

4 SUP. YAROSLAVSKY: YEAH. I HAVE A COUPLE OF QUESTIONS. NUMBER 

5 ONE, IS THIS ONLY APPLYING TO SCHOLL AND SUNSHINE CANYON 

6 LANDFILLS? 

7

8 SPEAKER: THAT'S CORRECT. 

9

10 SUP. YAROSLAVSKY: AND SO WHEN IT SAYS REQUEST THE STATE 

11 DEPARTMENT OF RESOURCE RECOVERY AND RECYCLING AND OTHER LOCAL 

12 JURISDICTIONS TO ALSO GRANT A 90-DAY EXCEPTION, WHAT ARE THOSE 

13 OTHER LOCAL JURISDICTIONS? 

14

15 SUP. ANTONOVICH: GLENDALE. 

16

17 SPEAKER: WELL THE CITIES OF GLENDALE, LA CANADA FLINTRIDGE 

18 HAVE SIMILAR NEEDS. THE CITY OF LA CANADA FLINTRIDGE IS 

19 SUFFERING FROM PROPERTY DAMAGE AND MUD FLOWS IN PROPERTIES, 

20 AND SO WE'RE SEEKING TO HAVE THE FEE RELATED TO THOSE 

21 MATERIALS TAKEN THERE WAIVED AS WELL, SUPERVISOR. 

22

23 SUP. YAROSLAVSKY: TO HAVE THE FEES FOR THE MATERIALS BEING 

24 TAKEN FROM THOSE OTHER JURISDICTIONS? OR THE OTHER 

25 JURISDICTIONS' FEES? 
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1

2 SPEAKER: THERE ARE MATERIALS THAT ARE WITHIN PRIVATE PROPERTY 

3 IN THOSE JURISDICTIONS THAT ARE BEING TAKEN TO THE LANDFILL, 

4 AS WELL. AND WE ALSO HAVE FLOOD CONTROL FACILITIES WITHIN 

5 THOSE JURISDICTIONS THAT ARE TAKING MATERIAL FROM THOSE 

6 FACILITIES TO THE SITE, TO THE LANDFILL. 

7

8 SUP. YAROSLAVSKY: SO WHEN YOU SAY AN INTERLOCAL JURISDICTION 

9 TO ALSO GRANT 90-DAY EXCEPTION. SO YOU'RE TALKING THE OTHER 

10 LOCAL JURISDICTIONS IN THIS CASE ARE GLENDALE BECAUSE OF 

11 SHOAL. SHOAL'S IN GLENDALE? 

12

13 SUP. ANTONOVICH: YES. 

14

15 SUP. YAROSLAVSKY: AND SUNSHINE IS PARTLY WITHIN THE CITY. 

16 WITHIN THE CITY AND COUNTY. SO IS THAT WHAT YOU'RE REFERRING 

17 TO? THIS MOTION ONLY APPLIES TO THOSE TWO LANDFILLS? 

18

19 SPEAKER: THAT'S CORRECT, SUPERVISOR. 

20

21 SUP. YAROSLAVSKY: OKAY. LAST QUESTION. IN THE SECOND-TO-LAST 

22 BULLET ON THE PAGE 3, IT SAYS "DIRECT DIRECTOR OF PUBLIC WORKS 

23 TO WORK WITH THE STATE TO WAIVE ANY APPLICABLE FEES WHEN 

24 DISASTER-RELATED MATERIALS MANAGED AT THE SUNSHINE CANYON AND 

25 SCHOLL CANYON LANDFILLS." WHAT ARE THE DISASTER-RELATED 
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1 APPLICABLE FEES AND DISASTER-RELATED MATERIALS? IS THAT THE 

2 NORMAL TIPPING FEE? 

3

4 SPEAKER: THE TIPPING FEE IS FROM THE STATE OF CALIFORNIA. 

5

6 SUP. YAROSLAVSKY: THE STATE HAS A TIPPING FEE? 

7

8 SPEAKER: THE STATE HAS REGULATIONS OVER THE LANDFILL, AS WELL, 

9 SUPERVISOR. WHAT THIS DIRECTS US TO DO IS WORK WITH THE STATE 

10 OF CALIFORNIA BECAUSE OF THE PROCLAMATION OF EMERGENCY TO LOOK 

11 AT ANY OTHER FEES THAT MAY BE RELATED TO BE WAIVED BY THE 

12 STATE, AS WELL. 

13

14 SUP. YAROSLAVSKY: THE STATE HAS, ON TOP OF THE TIPPING FEES 

15 THAT THE COUNTY AND THE CITY HAVE UP THERE AT SUNSHINE AND AT 

16 SHOAL, THE STATE HAS ITS OWN TIPPING FEE OVER AND ABOVE THOSE 

17 THAT ARE-- 

18

19 SPEAKER: I DON'T KNOW IF IT'S A TIPPING FEE. I KNOW THERE'S 

20 OTHER REGULATIONS THAT AFFECT OUR ABILITY. 

21

22 SUP. YAROSLAVSKY: SO SOME OTHER KIND OF FEES THAT THE STATE 

23 IMPOSES JUST BECAUSE OF DISASTER-RELATED DEBRIS? 

24
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1 SPEAKER: IT'S RELATED TO MOVEMENT OF THE DISASTER-RELATED 

2 MATERIAL. AND WE'RE SEEKING THE STATE'S COOPERATION, ALONG 

3 WITH OUR LOCAL AGENCIES, IN GETTING THE MATERIAL TO THE 

4 LANDFILL. SO WHATEVER FEES OR REGULATIONS ARE RELATED TO THAT, 

5 WE'RE DIRECTED THROUGH THE MOTION TO BE WORKING WITH THE STATE 

6 TO ADDRESS THIS. 

7

8 SUP. YAROSLAVSKY: MY LAST QUESTION IS THIS: THIS HAS BEEN 

9 DECLARED A DISASTER SITUATION UP IN THE STATION FIRE AREA. ARE 

10 WE EXPECTED TO GET ANY KIND OF REIMBURSEMENT FROM F.E.M.A. FOR 

11 ANY OF THESE COSTS? AND IF SO, WOULDN'T SOME OF THESE FEES BE 

12 REIMBURSABLE? OR NOT? 

13

14 SPEAKER: WE CURRENTLY DO NOT HAVE A FEDERAL DECLARATION OF 

15 DISASTER. WE ARE WORKING ON ESTABLISHING THAT BY PUTTING 

16 TOGETHER THE NUMBERS AND DRAWING UP THE SITUATION FOR THE 

17 FEDERAL GOVERNMENT, BUT WE CURRENTLY HAVE NOT RECEIVED A 

18 FEDERAL PROCLAMATION OF DISASTER. 

19

20 SPEAKER: HAVE YOU SUBMITTED IT TO THE FEDERAL GOVERNMENT YET? 

21

22 SPEAKER: WE ARE WORKING ON THAT WITH THE STATE OF CALIFORNIA. 

23

24 SUP. YAROSLAVSKY: SO YOU HAVEN'T SUBMITTED IT YET SO YOU DON'T 

25 KNOW WHETHER YOU'LL GET IT. 
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1

2 SPEAKER: WE'RE IN COMMUNICATION. 

3

4 SUP. YAROSLAVSKY: DO YOU ANTICIPATE WE WILL GET IT BASED ON-- 

5 ? 

6

7 SPEAKER: I'M HOPING WE WILL, SUPERVISOR, ONCE WE ACTUALLY 

8 CHARACTERIZE THE MAGNITUDE OF THE EVENT. THIS IS A THREE TO 

9 FIVE-YEAR EMERGENCY EVENT AT A MINIMUM. THE AMOUNT OF MATERIAL 

10 THAT WE ANTICIPATE TO RECEIVE WITHIN THE DEBRIS BASINS AS WELL 

11 AS THE RESERVOIRS THAT ARE IMPACTED IS SIGNIFICANT. IT WILL BE 

12 WELL OVER A 20 TO $30 MILLION REMOVAL OF MATERIAL IN JUST THIS 

13 ONE SEASON. SO WE'RE LOOKING AT HUNDREDS OF MILLIONS OF 

14 DOLLARS OVER A NUMBER OF YEARS BEFORE WE'RE ACTUALLY DONE WITH 

15 THE AMOUNT OF DEBRIS WE EXPECT TO RECEIVE OFF THE STATION FIRE 

16 AREA. 

17

18 SUP. YAROSLAVSKY: AND IF IT WERE TO BE DECLARED A DISASTER BY 

19 THE FEDERAL GOVERNMENT, WOULD THESE FEES BE REIMBURSABLE? 

20 THESE COSTS WOULD BE REIMBURSABLE? 

21

22 SPEAKER: ALL ACTIVITIES RELATED TO THE DEBRIS REMOVAL AND 

23 PLACEMENT WOULD BE SUBJECT TO BE QUALIFYING FOR RELIEF FROM 

24 THE FEDERAL GOVERNMENT, YES. 

25
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1 SUP. YAROSLAVSKY: SO BY WAIVING THE FEES NOW, DO WE FORFEIT 

2 OUR ABILITY TO GET REIMBURSEMENT FROM THE FEDERAL GOVERNMENT? 

3 TWO MONTHS FROM NOW? 

4

5 SPEAKER: NO. WE ACTUALLY JUST TRACK OUR COSTS INCLUDING THE 

6 FEES THAT WOULD HAVE BEEN COLLECTED. 

7

8 SUP. YAROSLAVSKY: BUT IF SUNSHINE WAIVES ITS FEES, THEN YOU 

9 HAVE NO COSTS IN THAT REGARD? 

10

11 SPEAKER: WE STILL HAVE FEES RELATED TO SUNSHINE CANYON WHEN WE 

12 DELIVER THE-- THIS REPRESENTS ABOUT 10 PERCENT OF THE COST TO 

13 ACTUALLY PLACE MATERIAL AT SUNSHINE. 

14

15 SUP. YAROSLAVSKY: WHAT ARE THE FEES YOU'RE ASKING TO BE WAIVED 

16 IN THIS MOTION FROM SUNSHINE? IT'S NOT THE TIPPING FEE ITSELF, 

17 IS IT? OR IS IT? 

18

19 SPEAKER: I HAVE TO BRING ONE OF OUR SANITATION FOLKS INTO THE 

20 ROOM TO HAVE THEM GIVE YOU THE EXACT COUNTY FEES THAT ARE 

21 COLLECTED THERE. I DON'T WANT TO MISSPEAK TO IT IF COUNTY IS 

22 AWARE OF IT. 

23
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1 SUP. YAROSLAVSKY: THAT'S FINE. I HAVE NO PROBLEM WITH THIS. I 

2 JUST WANT TO MAKE SURE THAT WE'RE NOT DOING SOMETHING THAT 

3 FORFEITS OUR ABILITY TO RECOVER. 

4

5 GAIL FARBER: I DON'T THINK IT FORFEITS OUR ABILITY TO RECOVER 

6 IT. I THINK THE IMPORTANCE OF WAITING UP FRONT IS WHILE WE'RE 

7 WORKING WITH COUNTY, AND HOPEFULLY THE F.E.M.A. FOR FEDERAL 

8 REIMBURSEMENT. THE DISTRICT HAS ALL THIS UPFRONT COST THAT 

9 NEED TO BE UP FRONT. THEY NEED TO BE [OFF MIC.] 

10

11 SUP. YAROSLAVSKY: I UNDERSTAND, GAIL. I UNDERSTAND. BUT WHAT 

12 I'M SAYING, IF I WERE THE FEDERAL GOVERNMENT AND YOU HAD 

13 WAIVED THE FEES, I'D SAY THAT'S NOT A COST TO YOU. YOU WAIVED 

14 THE FEES. IT WAS YOUR CALL, NOT OUR CALL. WE'RE NOT 

15 REIMBURSING YOU FOR FEES YOU DIDN'T HAVE TO PAY. THAT'S WHAT 

16 I'M TRYING TO-- AND MAYBE THERE'S AN ACCOUNTING MECHANISM HERE 

17 THAT WE COULD CREDIT WITH THE UNDERSTANDING THAT IF WE DON'T 

18 GET REIMBURSED, WE CAN ALWAYS FORGIVE THE LOAN, SO TO SPEAK. 

19 BUT SO THAT ON THE BOOKS, IT REGISTERS AS A COST. BECAUSE THIS 

20 COULD BE A CHUNK OF DOUGH HERE. NOT AS MUCH-- WELL, IT'S A 

21 CHUNK OF DOUGH TO US AND IT'S A CHUNK OF DOUGH TO THE LANDFILL 

22 SITE WHICH HAS OBLIGATIONS. I'M JUST TRYING TO FIGURE OUT A 

23 WAY THAT THE FEDERAL GOVERNMENT IS GOING TO PAY FOR THIS THAT 

24 WE DON'T WALK AWAY AND LEAVE THE MONEY ON THE TABLE. 

25
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1 SPEAKER: WE NEED TO INVESTIGATE THAT. BUT I DO WANT TO ASSURE 

2 YOU THAT THIS IS OUR LOWEST PRIORITY WITH RESPECT TO WHERE 

3 MATERIAL SHOULD BE GOING. 

4

5 SUP. YAROSLAVSKY: THIS IS YOUR LOWEST PRIORITY? 

6

7 SPEAKER: THE LANDFILL IS NOT OUR HIGHEST PRIORITY. ACTUALLY IT 

8 IS OUR LOWEST PRIORITY. IT'S OUR LAST RESORT, IF YOU WILL. SO 

9 WE INTEND TO LIMIT THE AMOUNT OF LANDFILL MATERIAL WE TAKE 

10 THERE. 

11

12 SUP. YAROSLAVSKY: YEAH, I UNDERSTAND. THAT'S FINE. ALL I'M 

13 ASKING NOW IS MAYBE, ANDREA, IF THE MECHANISM IS GOING TO BE 

14 TO AUTHORIZE YOU TO FIGURE ALL THIS OUT, IS THAT ONE OF THE 

15 THINGS YOU OUGHT TO DO IS STRUCTURE IT IN SUCH A WAY THAT 

16 WHATEVER FEES, RATHER THAN BE WAIVED, THAT THEY BE CREDITED, 

17 SOMETHING THAT SHOWS ON THE BOOKS AS AN OBLIGATION ON OUR PART 

18 TO PAY THE LANDFILL, WHETHER IT'S TIPPING FEES OR ANY OTHER 

19 KIND OF FEES, SO THAT WE CAN TRUTHFULLY SEEK REIMBURSEMENT 

20 FROM THE FEDERAL GOVERNMENT IF AND WHEN-- AND I'D BE SHOCKED 

21 IF THEY DIDN'T-- DECLARE THIS A FEDERAL DISASTER AREA FOR 

22 THESE PURPOSES. SO THAT IF AND WHEN THEY DO THAT, WE COULD 

23 RECOUP THESE COSTS. DO YOU UNDERSTAND WHAT? YOU UNDERSTAND 

24 WHAT I'M SAYING, RIGHT, MARK? 

25
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1 SPEAKER: YES, I DO. 

2

3 SUP. YAROSLAVSKY: GAIL? SO MAYBE YOU GUYS CAN WORK THAT OUT SO 

4 THAT WE DON'T FORFEIT SOMETHING UP FRONT. OKAY. 

5

6 ANDREA ORDIN, COUNSEL: AND I HAVE JUST A COUPLE OF WORDS TO 

7 ADD JUST TO MAKE CRYSTAL CLEAR THAT ON PAGE 2 OF 3, WHICH IS 

8 THE FIRST DIRECT, DIRECT THE DIRECTOR OF PUBLIC WORKS TO GRANT 

9 A 90-DAY WAIVER ON BEHALF OF THE COUNTY TO SUNSHINE CANYON 

10 LANDFILL. AND THAT WAY IT MAKES IT CRYSTAL CLEAR THAT ALL 

11 YOU'RE DOING IS WHAT'S WITHIN YOUR POWER, WHICH IS TO DIRECT 

12 THE DIRECTOR OF PUBLIC WORKS TO GRANT A WAIVER IF THE CITY IS 

13 NECESSARY TO ACTUALLY EFFECTUATE A 90-DAY WAIVER, THEN WE 

14 HAVEN'T IN ANY WAY INDICATED THAT IT WILL BE EFFECTIVE MERELY 

15 BY THIS MOTION. 

16

17 SUP. YAROSLAVSKY: WHICH BULLET WERE YOU LOOKING AT? 

18

19 ANDREA ORDIN, COUNSEL: BULLET 1 IT'S PAGE 2 OF 3." I 

20 THEREFORE?" 

21

22 SUP. YAROSLAVSKY: SO THE FIRST BULLET? RESTATE. 

23

24 ANDREA ORDIN, COUNSEL: IT'S BEEN REVISED. SO IT'S NOW ON 

25 WHERE? IT'S ON PAGE 3 NOW. "DIRECT THE DIRECTOR OF PUBLIC 
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1 WORKS TO WORK WITH THE STATE." I'M SORRY. WHERE IS THE WAIVER 

2 LANGUAGE? 

3

4 SUP. YAROSLAVSKY: GRANT A 90-DAY WAIVER OF ANY COUNTY FEES. 

5

6 ANDREA ORDIN, COUNSEL: WE'LL BRING IT BACK IN A MOMENT OR TWO 

7 WITH THE NEW LANGUAGE. 

8

9 SUP. YAROSLAVSKY: MORE COMPLICATED THAN YOU THOUGHT. DO YOU 

10 WANT TO HOLD IT ON THE DESK FOR A FEW MINUTES? 

11

12 SUP. MOLINA, CHAIR: YEAH, WE COULD GO INTO PUBLIC COMMENT. WE 

13 HAVE SOME PEOPLE ON PUBLIC COMMENT. WE HAVE ONE ITEM AND THEN 

14 WE HAVE PUBLIC COMMENT. THAT WAY WE CAN WORK OUT THESE 

15 DETAILS. LET'S DO THAT. ALL RIGHT. WE HAVE ONE ITEM HAS BEEN 

16 HELD BY MR. SACHS. IF HE'D COME UP AND JOIN US. THAT IS ITEM 

17 16? 16, MR. SACHS. THANK YOU. YES, GOOD MORNING. 

18

19 ARNOLD SACHS: [OFF MIC.] POSITION GENERATED BY THE GRANTS, 

20 THEY SHOULD PAY SALARY. THEY DON'T PAY THE BENEFITS. IF THAT'S 

21 THE CASE [OFF MIC.] EVERY TIME YOU-- FOR EVERY DOLLAR YOU PAY 

22 OUT IN GRANTS OR SALARIES, YOU HAVE TO FIND A SOURCE OF 

23 REVENUE, $2 TO PAY THE BENEFITS, BECAUSE BENEFITS USUALLY 

24 AMOUNT TO 66 PERCENT MORE, 200 PERCENT MORE OF WHAT SALARIES 

25 ARE. [OFF MIC.] BEFORE G.M. BECAME NOT G.M., THE STORY ABOUT 
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1 WHAT ARE THE COSTS? AS A MATTER OF FACT WHEN THEY PAY SOMEBODY 

2 A $25 SALARY, IT RESULTS IN A $75 IN BENEFITS. SO AGAIN THE 

3 QUESTION HERE IS THIS A GRANT PROGRAM THAT WOULD PROVIDE 

4 SALARIES, WHICH IS GOOD. BUT DOES THE COUNTY HAVE THE 

5 WHEREWITHAL TO COLLECT REVENUE TO SUPPLY THE BENEFITS? BECAUSE 

6 THERE'S A DRAIN. IF YOU PAY-- LIKE I SAID, IF YOU PAY $10 INTO 

7 THE COST OF MATERIAL, YOU GET THE $10 ON COST OF MATERIAL. AND 

8 WHAT'S UNIQUE ABOUT IT IS THE GRANTS THAT ARE GENERATED, 

9 WHEREVER THE FUNDING COMES FROM THE STATE OR FEDERAL 

10 GOVERNMENT, THAT MONEY IS GENERATED THROUGH TAXES. SO YOU PAY 

11 TAXES TO CREATE THIS FUNDING FOR THE DEPARTMENT TO GENERATE 

12 THESE GRANTS AND THEN YOU GET RE-TAXED TO MAKE UP THE 

13 DIFFERENCE TO PAY THE BENEFITS. BEVERLY HILLS [INAUDIBLE.] 

14 THEY DECLINE ON THEIR STUDENT LOAN, THE STUDENTS FROM L.A. TO 

15 GET ANY MORE GRANTS FROM THE STATE DEPARTMENT OF EDUCATION, 

16 THEREBY SAYING THAT THEY DON'T HAVE TO SERVE OUTSIDE STUDENTS 

17 IN THEIR SCHOOL DISTRICTS. BUT THE MONEY THAT WAS GENERATED 

18 PER STUDENT WASN'T JUST GOING TO SALARIES. THAT'S WHAT PEOPLE 

19 NEED TO LOOK AT. WHAT WAS THAT MONEY SPENT ON? AGAIN, THEY 

20 [INAUDIBLE]. AGAIN, A SOURCE FOR THE [INAUDIBLE] ARE CREATED 

21 BY THE MESS.. THANK YOU. 

22

23 SUP. MOLINA, CHAIR: THANK YOU. MR. SACHS, WHY DON'T YOU STAY 

24 SINCE WE'RE GOING TO DO PUBLIC COMMENT NEXT? OH, HE'S GOT SOME 

25 PAPERS HERE. SO, ON THAT ITEM, MOVED BY SUPERVISOR ANTONOVICH. 
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1 SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, 

2 SO ORDERED. ARE WE READY ON THAT? 

3

4 ANDREA ORDIN, COUNSEL: WE'RE READY ON THE LANGUAGE NOW. 

5

6 SUP. MOLINA, CHAIR: OKAY. GO AHEAD. WE'RE BACK ON THIS ITEM. 

7

8 ANDREA ORDIN, COUNSEL: ON PAGE 2, THE SECOND BULLET POINT, IT 

9 SAYS, "DIRECT THE DIRECTOR OF PUBLIC WORKS TO GRANT A 

10 TEMPORARY EXCEPTION, INSERT THERE 'ON BEHALF OF THE COUNTY' TO 

11 THE DAILY AND WEEKLY TONNAGE LIMITS." AND THEN IT GOES ON. ALL 

12 WE'RE DOING IS INSERTING THERE "ON BEHALF OF THE COUNTY" ON 

13 THE SECOND BULLET POINT. AND THEN WE DROP DOWN TO THE FIFTH 

14 BULLET POINT, AND IT SAYS "GRANT A 90-DAY WAIVER ON BEHALF OF 

15 THE COUNTY" INSERT "ON BEHALF OF THE COUNTY" OF ANY COUNTY 

16 FEES. SO IT'S THE SAME INSERTION IN BOTH THE SECOND BULLET 

17 POINT AND THE FIFTH BULLET POINT. AND THEN WE'RE FINE. 

18

19 SUP. MOLINA, CHAIR: ALL RIGHT. IS THAT ACCEPTABLE? 

20

21 SUP. YAROSLAVSKY: YEAH. GOOD ENOUGH FOR HER. 

22

23 SUP. MOLINA, CHAIR: APPROPRIATE TECHNICAL AMENDMENTS THERE. 

24 MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR 
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1 YAROSLAVSKY. IF THERE IS NO OBJECTION, SO ORDERED ON THAT 

2 ITEM. 

3

4 SUP. ANTONOVICH: THAT'S ALL I HAVE. 

5

6 SUP. MOLINA, CHAIR: THAT'S ALL YOU HAVE. VERY GOOD. WE'RE 

7 GOING TO MOVE ON TO PUBLIC COMMENT. WE HAVE VARIOUS MEMBERS 

8 THAT WISH TO ADDRESS US. I DON'T KNOW IF MR. SACHS WAS STILL 

9 GOING TO COME UP. IF NOT, WE HAVE OTHER PEOPLE. WE HAVE 

10 MICHAEL RICHARDSON, WOULD YOU PLEASE JOIN US? FOLLOWED BY MARK 

11 TILFORD? THERESA SAUCEDO? AND WE HAVE ROOM FOR ONE MORE 

12 PERSON, IRENE PANG, IF THEY WOULD JOIN US, PLEASE. ALL RIGHT. 

13 MR. RICHARDSON, WOULD YOU BEGIN? 

14

15 MICHAEL RICHARDSON: YES, MY NAME IS MICHAEL RICHARDSON. FIRST 

16 OF ALL, I WANT TO THANK YOU FOR THIS OPPORTUNITY TO ALLOW 

17 PEOPLE TO COME IN AND SPEAK. I JUST LIKE TO HAVE EVERYONE'S 

18 ATTENTION BECAUSE MY NAME IS MICHAEL RICHARDSON. I AM THE 

19 FATHER OF MITRICE RICHARDSON. SHE'S THE YOUNG LADY THAT WAS 

20 RELEASED IN MALIBU, AND SHE HAS STILL NOT BEEN FOUND. AND WHAT 

21 I'M ADDRESSING THE BOARD FOR IS I FIRST WANT TO THANK YOU FOR 

22 THE MONEY FOR THE REWARD. HOWEVER, THAT POT IS STILL JUST 

23 SITTING IN PLACE. I HAVE EXONERATED ALL MY DOLLARS. I WAS 

24 WONDERING IF WE COULD LOOK AT OTHER STRATEGIC PLANS, MAYBE 

25 BILLBOARDS AND UTILIZE THE MONEY SOMEWHERE ELSE THAT WE CAN 
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1 HELP TRY TO FIND OUT WHAT HAPPENED TO MITRICE. IT'S BECOMING-- 

2 I'VE LOST ONE JOB. I WAS WORKING TWO FULL-TIME JOBS, WHICH WAS 

3 A BENEFIT FOR ME IN THIS TIME. BUT I'M WORKING ON MY SECOND 

4 JOB IF I DON'T GET THINGS TOGETHER. AND ALL OF YOU WHO HAVE 

5 CHILDREN CAN UNDERSTAND MY POSITION. AND I NEED SOME ANSWERS. 

6 THIS IS VERY DIFFICULT FOR ME. AND I'M TIRED OF PEOPLE 

7 POINTING FINGERS AND BLAMING. WE DON'T KNOW WHAT HAPPENED. AND 

8 THAT'S WHY I'M HERE TODAY IS TO FIND OUT WHAT HAPPENED. YOU 

9 GUYS ASKED SHERIFF BACA TO COME IN. GREAT GUY. I SPOKE WITH 

10 HIM. HE'S GIVEN ME HIS BUSINESS CARD. BUT I DON'T LIKE TO 

11 UTILIZE MY WELCOME THAT MUCH. I JUST WANT TO SEE THAT WE KEEP 

12 MY DAUGHTER'S CASE OPEN. I FEEL LIKE IT'S GROWING COLD. AND 

13 ANYTHING THAT I COULD RELY UPON YOU GUYS TO DO TO HELP ME, I 

14 WOULD GREATLY APPRECIATE IT. 

15

16 SUP. MOLINA, CHAIR: THANK YOU, MR. RICHARDSON. YOU HAVE BEEN 

17 WORKING WITH WHICH SUPERVISORIAL OFFICE? 

18

19 MICHAEL RICHARDSON: MR. THOMAS. 

20

21 SUP. MOLINA: MR. RIDLEY-THOMAS, WE WILL MAKE SURE THAT HIS 

22 STAFF WORKS CLOSELY WITH YOU IF THERE'S OTHER STRATEGIES WE 

23 CAN IMPLEMENT. BUT THANK YOU SO MUCH FOR JOINING US TODAY. ALL 

24 RIGHT. WE HAVE MARK TILFORD? 

25
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1 MARK TILFORD: GOOD MORNING, THANK YOU VERY MUCH FOR ALLOWING 

2 ME TO SPEAK THIS MORNING AT THIS BOARD OF SUPERVISORS MEETING. 

3 MY NAME IS MARK TILFORD, CALIFORNIA [INAUDIBLE] RESIDENT OF 

4 REDONDO BEACH FOR OVER 35 YEARS. I'M SORRY THAT MY SUPERVISOR 

5 CANNOT BE HERE TO ATTEND TODAY. OUR STATE DEFICIT IS EXPECTED 

6 TO GROW AGAIN TO $30 TRILLION BY THIS JUNE. SACRAMENTO'S 

7 GROWTH AND [INAUDIBLE] CAREER POLITICIANS HAVE [INAUDIBLE]. 

8 I'M HERE TO MAKE THE PUBLIC AWARE THAT I'M CIRCULATING A 

9 PETITION FOR PLACEMENT ON THIS NOVEMBER'S GENERAL ELECTION 

10 BALLOT A CONSTITUTIONAL AMENDMENT TITLED [INAUDIBLE] ACT OF 

11 2010, CALIFORNIA [INAUDIBLE] LEGISLATURE WHICH IS SPEARHEADED 

12 BY A GROUP OF CITIZENS FOR CALIFORNIA [INAUDIBLE] RETURN 

13 CALIFORNIA BACK TO A PART TIME LEGISLATURE, WHICH IS WHAT WE 

14 HAVE UNTIL THE MIDDLE 1960S. THE BIGGEST CHANGE CAME IN 1966 

15 WHEN CALIFORNIA VOTERS ENACTED A SWEEPING REVISION OF THE 

16 STATE CONSTITUTION [INAUDIBLE] PROVIDING FOR A FULL-TIME 

17 LEGISLATURE WITH NO LIMITATION ON THE DURATION OF THE 

18 LEGISLATIVE SESSION. THE RESULT IS A LEGISLATURE DOMINATED BY 

19 CAREER POLITICIANS BEHOLDEN TO SPECIAL INTERESTS. [INAUDIBLE] 

20 THE PEOPLE THEY REPRESENT BY RETURNING TO PART-TIME CITIZEN 

21 LEGISLATURE REPRESENTED [INAUDIBLE] REGULAR SESSION AND RETURN 

22 TO THEIR RESPECTIVE DISTRICTS [INAUDIBLE] THE RULES THAT THEY 

23 MAKE AMONG THE PEOPLE THEY REPRESENT, GIVING REAL LIFE 

24 EXPERIENCE TO THE LEGISLATURE. THERE ARE 43 OTHER STATES THAT 

25 CURRENTLY HAVE PART-TIME LEGISLATURE. [INAUDIBLE] CITIZENS 
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1 [INAUDIBLE] CITIZEN LEGISLATURE REDUCE THE LEGISLATIVE SESSION 

2 [INAUDIBLE]. VOTER PASSAGE OF THIS COULD POTENTIALLY SAVE THE 

3 STATE HUNDREDS OF MILLIONS IN DOLLARS. PLEASE BE AWARE THAT I 

4 AM A VOLUNTEER. [INAUDIBLE] I'M NOT A PAID CITIZEN 

5 [INAUDIBLE]. I DO THIS BECAUSE I BELIEVE THIS IS THE RIGHT 

6 THING TO DO FOR THE CITIZENS, TAXPAYERS AND OTHERS. 

7 [INAUDIBLE] RECEIVED THIS PETITION AND INSTRUCTIONS TO DO YOUR 

8 PART IN HELPING US TO HELP OURSELVES TO SAVE OUR CALIFORNIA. 

9 AND I ASK THAT THE CITY CLERK [INAUDIBLE] RECEIVE THESE 

10 PETITIONS [INAUDIBLE] FOR SUPERVISORS. I ASK YOU FOR PERSONAL 

11 COMMITMENT [INAUDIBLE] TO PARTICIPATE IN THIS CRITICALLY 

12 IMPORTANT CIVIC RESPONSIBILITY. [INAUDIBLE] SHOULD CALIFORNIA 

13 LAWMAKERS BE PART-TIME? 

14

15 SUP. MOLINA, CHAIR: THANK YOU, SIR. 

16

17 MARK TILFORD: 2010 SIGN YOUR PETITIONS HERE. ARE THERE ANY 

18 COMMENTS OR QUESTIONS THAT THE SUPERVISORS HAVE AT THIS TIME 

19 BEFORE I EXCUSE MYSELF? 

20

21 SUP. MOLINA, CHAIR: THANK YOU, NO. BUT WE APPRECIATE YOU BEING 

22 HERE. 

23

24 MARK TILFORD: THANK YOU VERY MUCH. I'LL BE WAITING OUTSIDE TO 

25 MEET WITH THE CITIZENS. THANK YOU. 
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1

2 SUP. MOLINA, CHAIR: THANK YOU. CERTAINLY. NEXT WE HAVE MS. 

3 SAUCEDO. 

4

5 THERESA SAUCEDO: GOOD MORNING. I WANT TO SPEAK ON BEHALF OF MY 

6 SISTER. 

7

8 SUP. MOLINA, CHAIR: COULD YOU SPEAK UP JUST AT THE MICROPHONE 

9 A LITTLE CLOSER TO YOU SO WE COULD HEAR YOU? 

10

11 THERESA SAUCEDO: I'M HERE TO SPEAK ON BEHALF OF MY SISTER, 

12 ZETA CORTES AND DEALINGS OR PROBLEMS THAT SHE'S BEEN HAVING 

13 WITH CHILDREN'S SERVICES AND THE SOCIAL WORKERS, CLARENCE 

14 PEEK, L.L. GUDINES, FERGUSON, ERICA SANCHEZ, LIZ REYES, JOHN 

15 RAMOS, MARGARET BALLPEN. IT'S VERY OBVIOUS THAT THEY'RE 

16 SHARING HER CASE BECAUSE THEY DON'T SEEM TO HAVE ENOUGH WORK 

17 TO TAKE CARE OF THEIR OWN CASES WHERE THEY HAVE ENOUGH WORK. 

18 BUT THEY SEEM TO BE ABLE TO FABRICATE AND MAKE INADEQUATE 

19 REPORTS, YOU KNOW, ON HER BEING A DRUG ADDICT. AND THE THING 

20 IS SHE'S NEVER BEEN ARRESTED. SHE'S NEVER GONE TO A HOSPITAL 

21 FOR THE DRUGS. SHE'S NEVER BEEN ADMITTED ANYWHERE. THERE'S NO 

22 PAPER TO SHOW IN HER PAST. SO TO ME, THEY'RE NOT DOING THEIR 

23 JOB. SHE HAS AN ATTORNEY AND EVERYBODY KEEPS PASSING THE BUCK 

24 ON, YOU KNOW, LIKE WHAT THEY'RE SUPPOSED TO DO. THERE'S 

25 SUPPOSED TO BE LIKE A TRANSCRIPT AND THE TRANSCRIPT GIVES THE 
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1 ORDERS. AND INSTEAD THEY COME UP WITH THE MANY CASE AND IT 

2 DOESN'T SAY HARDLY ANYTHING, YOU KNOW. NOTHING OF WHAT THE 

3 JUDGE ORDERED. HE ORDERED VISITS WITH HER. SHE HASN'T SEEN HER 

4 DAUGHTER IN FOUR MONTHS. HER DAUGHTER'S ALREADY YOU KNOW LIKE 

5 WHERE SHE DOESN'T WANT TO SEE HER OR TALK TO HER. BUT THAT'S 

6 THE WORK OF CHILDREN'S SERVICES. THE CHILD HAS BEEN 

7 BRAINWASHED AND IS SCARED. IT'S VERY OBVIOUS. I DON'T SEE HOW 

8 ANYBODY CAN NOT SEE THIS. I JUST WANT FOR SOMEONE TO DO THEIR 

9 JOB AND LOOK OVER THESE PEOPLE TO KNOW THAT THEY'RE DOING 

10 THINGS THE WAY THEY WANT TO DO THEM. THEY'RE NOT FOLLOWING THE 

11 LAW. I WAS AT THE COURT. I HEARD WHAT THE COMMISSIONER AS 

12 JUDGE ORDERED. HE ORDERED VISITS. AND THEY SAY THERE'S NOTHING 

13 THAT SAYS THAT. WELL YET THEY DON'T GIVE A TRANSCRIPT, YOU 

14 KNOW. HER ATTORNEY DOESN'T GET A TRANSCRIPT. THEY'RE NOT DOING 

15 ANYTHING FOR HER. THEY'RE DOING AS THEY WANT. 

16

17 SUP. MOLINA, CHAIR: IS THERE AN ORDER TO HAVE CHILD 

18 VISITATIONS? 

19

20 THERESA SAUCDEO: PARDON? 

21

22 SUP. MOLINA, CHAIR: IS THERE AN ORDER TO HAVE CHILD 

23 VISITATIONS? 

24

25 THERESA SAUCDEO: I CAN'T HEAR YOU, MA'AM. 
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1

2 SUP. MOLINA, CHAIR: IS THERE AN ORDER TO HAVE CHILD 

3 VISITATIONS? 

4

5 THERESA SAUCDEO: YES, THERE IS. 

6

7 SUP. MOLINA, CHAIR: WHERE IS THE ORDER? 

8

9 THERESA SAUCDEO: THE ORDER IS IN THE TRANSCRIPT. BUT NOBODY'S 

10 BRINGS OUT THE TRANSCRIPT. 

11

12 SUP. MOLINA: WHAT IS THE ORDER THAT YOU HAVE NOW FROM THE 

13 COURTS? 

14

15 THERESA SAUCDEO: WHAT IS THE ORDER I HAVE? 

16

17 SUP. MOLINA, CHAIR: WHAT IS THE ORDER YOUR DAUGHTER HAS? 

18

19 THERESA SAUCDEO: SHE'S SUPPOSED TO GET-- 

20

21 SUP. MOLINA, CHAIR: DO YOU HAVE IT THERE? 

22

23 THERESA SAUCDEO: THE ORDER FOR IS AT LEAST TWO VISITS THAT ARE 

24 AT LEAST TWO HOURS EACH, PER WEEK. SHE HASN'T SEEN HER 

25 DAUGHTER IN FOUR MONTHS. 
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1

2 SUP. MOLINA, CHAIR: I KNOW, HOW ARE THOSE VISITS SET UP? 

3

4 THERESA SAUCDEO: PARDON? 

5

6 SUP. MOLINA, CHAIR: HOW ARE THE VISITS SET UP? 

7

8 THERESA SAUCDEO: FOR HER TO BE WITH A SUPERVISED PERSON, I 

9 GUESS, WITH SOMEONE THERE. 

10

11 SUP. MOLINA, CHAIR: YOU SHOULDN'T BE GUESSING. YOU SHOULD 

12 KNOW. THERE IS SOMEONE HERE FROM CHILDREN'S SERVICES THAT IF 

13 YOU HAVE SUCH AN ORDER, WE CAN HELP YOU IMPLEMENT THAT ORDER. 

14

15 THERESA SAUCDEO: WELL IF SOMEONE COULD GET ME THE TRANSCRIPT, 

16 WE COULD READ IT OUT OF THERE. 

17

18 SUP. MOLINA, CHAIR: I'M NOT SO SURE I CAN GET YOU THE 

19 TRANSCRIPT. 

20

21 THERESA SAUCDEO: NOT THE MINUTE ORDER, THE TRANSCRIPT. 

22

23 SUP. MOLINA, CHAIR: AGAIN, I ASKED YOU IF YOU HAVE AN ORDER. 

24 IF YOU HAVE AN ORDER, WE HAVE SOMEONE FROM CHILDREN'S SERVICES 

25 WHO WILL HELP YOU IMPLEMENT THAT ORDER, OKAY? 
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1

2 THERESA SAUCDEO: I HOPE SO. I THANK YOU FOR LISTENING. 

3

4 SUP. MOLINA, CHAIR: THANK YOU. I APPRECIATE YOUR HELP. ARE YOU 

5 THE GENTLEMAN WHO CAN HELP US? OKAY. COULD YOU HELP THEM MAKE 

6 SURE THEY UNDERSTAND WHAT THE ORDER IS? AND AGAIN I DON'T KNOW 

7 ANY ISSUE ABOUT A TRANSCRIPT, BUT MAKE SURE THAT THAT ORDER IS 

8 IMPLEMENTED. THANK YOU. BEFORE I CALL ON MISS PANG, COULD WE 

9 ALSO BE JOINED BY OSCAR JOHNSON? AND OF COURSE MR. SACHS. AND 

10 FINALLY BOBBY COOPER. PLEASE JOIN US. MISS PANG? 

11

12 IRENE PANG: HI. GOOD MORNING. SUPERVISOR. I'M IRENE PANG. I'D 

13 LIKE TO DISCUSSING ABOUT A CONTRACT. THE CONTRACT IS COMMON 

14 THE DOCUMENTATION BETWEEN THE BUSINESS AND THEN BETWEEN THE 

15 PATIENT-- PERSON. BUT SOMETIMES THEY USING THE CONTRACTS THAT 

16 YOU RECOGNIZE, THAT YOU HAVE SITUATION HAPPEN SUCH IS SOME 

17 THEY USING THEIR CONTRACT THE HOURS FOR THEIR VISIT IS THE 

18 OWNER THEY CONTROL. AND THEY MAKE THEIR CONTRACT TO OFFER THEM 

19 THEIR BUSINESS AND THEIR CONTROL TO MAKE THEIR CONTRACT LIKE 

20 THEY SELL THE BUSINESS BY THE PERSONAL AND DOING SOME KIND OF 

21 BUSINESS THAT THEY TRADE, IS THEY ARE THE EMPLOYEE OR 

22 IRREGULAR THE PERSON, OF WHO THE PERSON IS DOING THE BUSINESS 

23 ILLEGALLY TO MAKE THE CONTRACT. I OFFER THEM ALL THOSE 

24 ACTIVITIES OUT FROM THE BUSINESS OWNER, THE CONTROL. THOSE 
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1 THAT ACTIVITIES INVOLVED AND AGAINST THEIR KNOW. AND THOSE 

2 KIND OF CONTRACTS SHOULD BE VOIDED. THANK YOU. 

3

4 SUP. MOLINA, CHAIR: THANK YOU, MISS PANG. MR. JOHNSON? 

5

6 OSCAR JOHNSON: MY NAME IS OSCAR. I SPEAK FOR THE OPPRESSED. I 

7 SPEAK FOR THE STRUGGLING POOR. AND I SPEAK FOR CULTURE CHANGE. 

8 I'D LIKE THE THANK GOD FOR PRESIDENT BARACK OBAMA. THANK GOD 

9 FOR HIS WIFE MISS MICHELLE OBAMA. WE NEED TO END CORRUPTION IN 

10 GOVERNMENT. WE SHOULD END ILLEGAL IMMIGRATION. ON THE "LOS 

11 ANGELES TIMES" NEWSPAPER FEBRUARY THE FIRST ARTICLE WRITTEN TO 

12 SAY THAT THE REMOVAL OF ILLEGAL IMMIGRATION HAVE INCREASED 

13 UNDER THE OBAMA ADMINISTRATION. AND IN FISCAL 2009 THEY GREW 

14 TO 387,790 FROM 291,060 IN '07 UNDER BUSH ADMINISTRATION 

15 GOVERNMENT DATA SHOWS. WE SHOULD END CONSTRUCTION FRAUD. WE 

16 SHOULD LIMIT OUR RAILS, HOW MANY RAILS TO BE BUILT. WE NEED 

17 FOR BETTER BUSES. BUT WE HAVE SEEN THE BUS SERVICE HAVE 

18 DECREASES, SEEM AS THOUGH OUR FARE SHOULD DECREASE ON THE BUS, 

19 ON THE LOS ANGELES BUSES. WE NEED TO END OUR MORAL CONDUCT, WE 

20 NEED BETTER MORAL CONDUCT, END IMMORAL CONDUCT. WE HAVE NEED 

21 TO HAVE A SPIRITUAL AWAKENING. AND I'LL REPEAT ONCE BEFORE 

22 THAT PHARAOH REPRESENTED A CORRUPT GOVERNMENT. PHARAOH HAD TO 

23 TURN ISRAEL'S INTO ABUNDANCE AND AMONG MANY NATIONS HAD HARD 

24 CHANGES IN THE REALM OF SPIRIT IN THE CHILDREN ISRAEL. BUT 

25 AGAIN AND AGAIN THEY FELL IN THE SPIRIT AND REBELLED AGAINST 
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1 MOSES AND _____ IN THE WILDERNESS. THE PROPHET THEY SUE AND 

2 DECIDED THEY REJECTED IT. THEY FALSIFIED THE SCRIPTURE AND 

3 TURNED IT BACK ON RIGHTEOUSNESS. AND WE FIND THAT TODAY THAT 

4 THE MAJORITY OF AMERICAN PEOPLES TODAY, WE HAVE BEEN PRONE TO 

5 WORSHIP CREATION MORE THAN OUR CREATOR. BUT, ANYWAY, OUR 

6 DECLARATION OF INDEPENDENCE TEACHES US THAT WE SHOULD HAVE 

7 MORAL RESPONSIBILITY, MORAL OBLIGATION AND MORAL 

8 RELATIONSHIPS. WE SHOULD HAVE NO SEX UNTIL MARRIAGE. THAT IS 

9 AGAINST OUR CONSTITUTION, THAT IS AGAINST OUR DECLARATION OF 

10 INDEPENDENT, THAT IS AGAINST OUR CONSTITUTION, THAT IS ALSO 

11 AGAINST OUR FLAG AND IT IS ALSO AGAINST OUR BILL OF RIGHTS. 

12 OUR FLAG AND OUR DECLARATION OF INDEPENDENCE, OUR CONSTITUTION 

13 DO NOT REPRESENT ANYTHING THAT IS UNCLEAN. WE HAVE A 

14 GOVERNMENT THAT REPRESENTS EVERYTHING CLEAN. BUT IT SEEMS AS 

15 THOUGH WE HAVE PEOPLE HAVE CAME IN HAVE SOLD OUR GOVERNMENT 

16 OUT, THOUGH. SEEMS LIKE AMERICA IS FOR SALE. WE GOT TO COME 

17 BACK TO WHAT IS RIGHT AND WHAT AMERICA REALLY STANDS FOR. THE 

18 DECLARATION OF INDEPENDENCE STATE THAT GOVERNMENT EXISTS TO 

19 PROTECT THE RIGHTS OF THE PEOPLE AND TO RECEIVE THEIR POWER TO 

20 RULE BY ONLY THROUGH THEIR AGREEMENT OF THE PEOPLE. THE 

21 DECLARATION OF INDEPENDENT ALSO FOR THE RIGHTS TO LIFE TO 

22 DEFEND ONE'S SELF AGAINST ATTACK AND THE PHYSICAL AND UNJUST 

23 GOVERNMENT. THE RIGHT FOR LIBERTY INCLUDES THE RIGHT TO 

24 CRITICIZE GOVERNMENT AND TO WORSHIP FREELY AND TO FORM A 

25 GOVERNMENT TO PROTECT THE LIBERTY OF THE PEOPLE, TO PURSUE 
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1 HAPPINESS MEANS THE RIGHT TO OWN PROPERTY AND HAVE IT 

2 SAFEGUARDED AND THE RIGHT TO STRIVE FOR THE GOOD OF ALL 

3 PEOPLE. 

4

5 SUP. MOLINA, CHAIR: THANK YOU, MR. JOHNSON. THANK YOU, SIR. 

6 ALL RIGHT. MR. SACHS? 

7

8 ARNOLD SACHS: GOOD MORNING. QUITE A QUICK MEETING. THANK YOU. 

9 I'M GOING TO TAKE MY THREE MINUTES TO SPEAK A LITTLE ABOUT THE 

10 M.T.A. AND AT ONE OF THE COMMITTEE MEETINGS THIS PAST WEEK, IF 

11 YOU WERE FORTUNATE ENOUGH, YOU COULD HAVE PICKED UP A COPY OF 

12 A BRIEF HISTORY OF THE M.T.A. EXCELLENT READING, BECAUSE IT 

13 GIVES YOU INSIGHT INTO ALL THE DECISIONS THAT WERE MADE 

14 REGARDING LIKE THE BLUE LINE AND THE RED LINE EXTENSIONS 

15 EXTENSIONS, THE GOLD LINE, HOW THAT WAS CREATED AFTER A-- WHAT 

16 WAS IT? THEY STOPPED BUILDING, MORATORIUM WAS DECLARED IN 

17 1998. THEN IT WAS RECREATED, IT WENT FROM THE BLUE LINE TO THE 

18 GOLD LINE. BUT I'M GETTING AHEAD OF MYSELF. LET ME READ THIS. 

19 CREATING AN INDEPENDENT CONSTRUCTION AUTHORITY-- THIS IS FROM 

20 THE FOOTHILL CONSTRUCTION AUTHORITY-- THE METRO GOLD LINE 

21 CONSTRUCTION AUTHORITY IS AN INDEPENDENT PLANNING AND 

22 CONSTRUCTION AGENCY CREATED IN 1998 BY THE CALIFORNIA STATE 

23 LEGISLATURE, S.B.1847. ITS SOLE PURPOSE WAS TO IMMEDIATELY 

24 RESUME DESIGN, CONTRACTING, CONSTRUCTION OF THE LOS ANGELES TO 

25 PASADENA METRO GOLD LINE FORMERLY THE PASADENA BLUE LINE WHICH 
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1 HAD BEEN SUSPENDED BY THE LOS ANGELES METROPOLITAN 

2 TRANSPORTATION AUTHORITY IN THE SAME YEAR. NOW LET ME READ 

3 THIS. WHAT IS THE METRO GOLD LINE FOOTHILL CONSTRUCTION-- 

4 EXTENSION CONSTRUCTION AUTHORITY? THE METRO GOLD LINE FOOTHILL 

5 EXTENSION CONSTRUCTION AUTHORITY IS AN INDEPENDENT 

6 TRANSPORTATION PLANNING AND CONSTRUCTION AGENCY CREATED IN 

7 1999 THROUGH LEGISLATION AUTHORED BY THEN STATE SENATOR ADAM 

8 SCHIFF. THE CONSTRUCTION AUTHORITY WAS CREATED TO DESIGN AND 

9 CONSTRUCT A LINE FOLLOWING SUSPENSION OF WORK ON THE PROJECT 

10 BY THE LOS ANGELES COUNTY METROPOLITAN TRANSPORTATION 

11 AUTHORITY IN 1998. THE SAME CONSTRUCTION AUTHORITY. NOW THE 

12 STATE CREATED A BLUE LINE CONSTRUCTION AUTHORITY. SO LAYING 

13 AROUND, BLUE WENT TO GOLD AND THE PUBLIC GOT SCREWED. HOW'D 

14 THAT HAPPEN? THEN WE HAVE THE RED LINE. OR UNFORTUNATELY, IT'S 

15 TOO BAD THAT SUPERVISOR THOMAS ISN'T HERE, BECAUSE HE 

16 QUESTIONED AN AUDIT REGARDING SPENDING. THIS IS FROM THE 2008 

17 LONG-RANGE TRANSIT PLAN THAT WASN'T ADOPTED. AND IN THIS IS 

18 ANATOMY OF A PROJECT. IN 2000, A MAJOR INVESTMENT STUDY 

19 CONSIDERS 47 ALTERNATIVES TO THE METRO RED LINE TO EAST L.A. 

20 THIS COMES FROM TRANSIT PEOPLE WHO SAY THAT THE RED LINE 

21 WESTBOUND HAD 17 ALTERNATIVES FROM WILSHIRE WESTERN TO 

22 FAIRFAX. SO 17 ALTERNATIVES THAT WAY. 47 ALTERNATIVES THE 

23 OTHER WAY. 64 ALTERNATIVES FOR A FIVE-MILE ROUTE. MAYBE YOU 

24 COULD DO AN AUDIT ON THAT TIME, ON THAT EXPENSE. WHAT DO YOU 

25 THINK, SUPERVISOR ANTONOVICH? YOU'RE UP-TO-DATE TO AUDIT THE 
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1 CONSTRUCTION AUTHORITY AND YOU WANT TO PROTECT THE PUBLIC 

2 AGAINST SLEAZY CONSTRUCTION COMPANIES, WHO'S GOING TO CHECK 

3 THE PUBLIC AGAINST SLEAZY POLITICIANS? DARN. I DON'T KNOW THE 

4 ANSWER TO THAT. 

5

6 SUP. MOLINA, CHAIR: ALL RIGHT. MR. COOPER? 

7

8 BOBBY COOPER: YES. ARE YOU HEARING ME? YES MY NAME IS BOB 

9 COOPER. I'M HERE TODAY TO ADDRESS THE ISSUE ABOUT MY MOTHER. I 

10 WAS HERE A FEW MONTHS AGO. AND AFTER SPEAKING WITH THIS ON AND 

11 OFF WEEKS AFTER WEEKS COMING BEFORE THE BOARD, NO ONE, NOT ONE 

12 OF YOUR WORKERS DID A DOGGONE THING FOR ME TO HELP ME FIND MY 

13 MOTHER. AS A MATTER OF FACT, THEY WEREN'T INSTRUMENTAL AT ALL 

14 IN HELPING FIND MY MOTHER. NOW SHE'S 12 WEEKS AFTER ADDRESSING 

15 THIS COUNCIL, MY MOTHER'S DEAD, YOU KNOW. AND I INFORMED YOU 

16 FROM THE VERY BEGINNING THAT THIS WAS ALL ABOUT INSURANCE 

17 MONIES. NOW, I DIDN'T EVEN HAVE A CHANCE TO BURY MY MOTHER. I 

18 SAW HER ONE TIME. SHE WAS BURIED LIKE A PAUPER. OR I DON'T 

19 KNOW WHAT HAPPENED TO HER BODY. BUT I KNOW THEY'RE TRYING TO 

20 KEEP ME FROM COLLECTING THE INSURANCE ON HER DEATH BY MY 

21 FATHER'S INHERITANCE. WHAT I'M HERE TODAY FOR IS I WANT THE 

22 INFORMATION TO FIND OUT WHO AND ALL MADE ALLEGATIONS AGAINST 

23 ME WHEREFORE MY MOTHER WOULD BE TAKEN AWAY FROM ME BECAUSE I 

24 WAS TAKING GOOD CARE OF HER. I'M A PROFESSIONAL CHEF AND A 

25 NUTRITIONIST AND I COULD TAKE CARE OF MY MOTHER IN SO FAR AS 
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1 THE MENTAL HEALTH RECORDS, THIS IS WHERE YOUR MONEY IS GOING 

2 RIGHT HERE. FRAUDULENT DOCUMENTS, MEDICAL RECORDS WHERE THESE 

3 DOCTORS ARE SAYING THEY'RE DOING THINGS. THIS STUFF NEVER 

4 HAPPENED. I'M GOING TO LEAVE THAT WITH YOU. I'M HERE TODAY 

5 BECAUSE MOST OF THE PROBLEMS THAT I'M HAVING IS FROM 

6 ATTORNEYS. CROOKED ATTORNEYS. ONE OF THEM BY IF NAME OF JOHN 

7 ALAN GOLDWIN BEEN HARASSING ME FOR 15 YEARS. NOW I FIND OUT 

8 SINCE I HIRED A LAW FIRM THAT THEY HAVE BEEN COMPROMISED, 

9 WHICH IS PARKER N STANBURY, AND PREPAID LEGAL. THEY'RE COMING 

10 IN MY ROOM. THEY'RE TAKING DOCUMENTS. THEY'RE WHITING OUT 

11 STUFF. THIS IS RIGHT AROUND THE CORNER FROM RAMPART. I'VE HAD 

12 PROBLEMS WITH RAMPART POLICE FOR SOME 15 YEARS. I WENT IN 

13 COURT AND GET RUN OUT OF TOWN. THIS IS WHAT I GET. THIS IS ME. 

14 THIS IS BEHIND ONE OF YOUR SOCIAL WORKERS, YOU KNOW, ALLEGING 

15 I'M SUPPOSED TO HAVE SOMETHING WRONG AND GET ME IN THE 

16 HOSPITAL, START KICKING ME IN THE CHEST BECAUSE I HAVE HEART 

17 PROBLEMS, TRYING TO INDUCE HEART ATTACK. I DON'T NEED THIS. I 

18 NEED HELP FROM YOUR SOCIAL WORKERS AND THE POLICE DEPARTMENT 

19 TO CONTROL THESE PEOPLE. WHO'S RUNNING THIS PLACE? WHO'S 

20 RUNNING THE COUNTRY? WHO'S RUNNING THE CITY OF LOS ANGELES. I 

21 DON'T NEED THIS. HERE YOU GOT NINE ATTORNEYS. NINE OF THEM 

22 COMMITTED FRAUD AGAINST ME AND MY MOTHER, STEALING OUR MONEY 

23 AND YOU GOT SOCIAL WORKERS PARTICIPATING IN THE PROJECT, YOU 

24 KNOW, TO DEFRAUD US. NOW I DON'T NEED TO COME UP HERE, EVERY 

25 TIME I COME UP HERE AND SPEAK WITH THE COUNCIL, I HAVE TO DEAL 
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1 WITH A BUNCH OF PEOPLE HAVING TO DO WITH MENTAL HEALTH. THERE 

2 IS NOTHING MENTAL ABOUT ME. NO, THERE'S NOTHING. I'VE BEEN 15 

3 YEARS IN LITIGATION AGAINST JOHN ALAN GOLDWIN IS NOTHING BUT A 

4 CROOK AND POSSIBLY HOOKED UP IN A HOMICIDE, TWO HOMICIDES WITH 

5 WITNESSES. NOW, I EXPECT SOMEBODY TO DO SOMETHING ABOUT THIS. 

6 YOU KNOW, I'M A CITIZEN. MAYBE I'M MAKE BLACK, MAYBE I'M THE 

7 WRONG COLOR. THANK YOU FOR PROTECTION. I NEED PROTECTION FROM 

8 YOUR LIP SERVICE. 

9

10 SUP. MOLINA, CHAIR: THAT CONCLUDES OUR PUBLIC COMMENT. WE DID 

11 HAVE ONE ITEM THAT WAS SCHEDULED FOR 11 O'CLOCK, WHICH IS A 

12 REPORT FROM L.A. COUNTY+ U.S.C. AND I'VE READ THE REPORT. 

13 UNLESS THERE'S ANY QUESTION OR COMMENT, I'M IN THE MOOD THAT 

14 WE RECEIVE AND FILE THAT REPORT. ALL RIGHT. MOVED AND 

15 SECONDED. WE'LL RECEIVE AND FILE. IS THERE ANY OTHER ITEMS 

16 BEFORE US? OKAY. THAT CONCLUDES OUR AGENDA. AND I'LL HAVE THE 

17 EXECUTIVE OFFICER READ US INTO CLOSED SESSION. 

18

19 CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, 

20 NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL 

21 CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. C.S.-1, 

22 CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION AS 

23 INDICATED ON THE POSTED AGENDA. THANK YOU. 

24

25
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1 REPORT OF ACTION TAKEN IN CLOSED SESSION ON FEBRUARY 23, 2010 

2

3

4

5 CS-1. CONFERENCE WITH LEGAL COUNSEL - EXISTING LITIGATION 

6 (Subdivision (a) of Government Code Section 54956.9) Jesse 

7 Rosenberger v. County of Los Angeles, et al., Los Angeles 

8 Superior Court Case No. SC099924

9

10 This litigation arises from a vehicle accident involving an 

11 employee of the Sheriff s Department. (10-0409) 

12

13 ACTION TAKEN: The Board authorized County Counsel to file an 

14 appeal in the aforementioned matter. 

15

16 The vote of the Board was unanimous with Supervisors Ridley 

17 Thomas and Knabe being absent. 

18

19 In Open Session, items CS-2 and CS-3 were continued one week 

20 to March 2, 2010.

21

22

23

24

25
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1 I, JENNIFER A. HINES, Certified Shorthand Reporter 

2 Number 6029/RPR/CRR qualified in and for the State of 

3 California, do hereby certify:

4      That the transcripts of proceedings recorded by the Los 

5 Angeles County Board of Supervisors February 23, 2010,

6 were thereafter transcribed into typewriting under my 

7 direction and supervision;

8      That the transcript of recorded proceedings as archived 

9 in the office of the reporter and which have been provided to 

10 the Los Angeles County Board of Supervisors as certified by 

11 me.

12      I further certify that I am neither counsel for, nor 

13 related to any party to the said action; nor

14 in anywise interested in the outcome thereof.

15      IN WITNESS WHEREOF, I have hereunto set my hand this 3rd 

16 day of March 2010, for the County records to be used only for 

17 authentication purposes of duly certified transcripts      

18 as on file of the office of the reporter.

19   

20                    JENNIFER A. HINES 

21              CSR No. 6029/RPR/CRR
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